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INTRODUCTION TO  
MICRO S OFT WORD 2 013

LEARNING OBJECTIVES 
1.1 Introduction

1.2 Exploring the parts of Word Window

1.3 The Backstage View

1.4 Creating Documents

1.5 Saving Documents

1.6 Closing  Documents

1.7 Opening  Documents

1.8 Editing Documents

1.9 Moving around in the document

1.1 INTRODUCTION
Microsoft Word 2013 is a word processing program that is used to create professional looking documents such 
as reports, letters, memos and newsletters. It includes many powerful tools that can be used to easily create and 
edit documents and collaborate with others. This module l provides an overview of the Word 2013 user interface 
and covers how to perform basic tasks such as starting and exiting the program, creating, saving, opening, closing, 
editing, formatting and printing documents, applying styles and getting help.

1.2 EXPLORING THE PARTS OF WORD WINDOW
Starting Word
To start Word 2013 from the Start menu 

1.	 Click the Start button > Click All Programs > Click Microsoft Office 2013 > Click Word 2013. The Start 
Screen appears.

2.	 In the right pane, click Blank document. A new, blank document opens in the program window.
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1.2 Exploring the parts of Word Window

The Word 2013 programs window is easy to navigate and simple to use.

Word 2013 Program Window Elements:

Name Description
Title Bar Appears at the top of the program window and 

displays the name of the document and the program. 
The buttons on the right side of the Title are used 
to get help, change the display of the Ribbon; and 
minimize, restore, Maximize and close the program 
window

Quick Access ToolBar Appears on the left side of the Title bar and contains 
frequently used commands that are independent of 
the tab displayed on the ribbon

Ribbon Extends across the top of the program window, directly 
below the Title Bar, and consists of a set of tabs, each 
of which contains groups of related commands/tools.

Navigation Pane Appears on the left side of the program window and 
enables you to navigate long documents, search for 
specific text, and reorganize content. Ctrl+F is the 
shortcut to bring up this pane.

Document Area The blank white space that appears below the Rular 
bar  and displays the contents of the document.

Insertion Point A blinking vertical line that indicates where text or 
objects will be inserted.
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Scroll Bars Appear along the right side and bottom of the 
document area window and enable you to scroll up 
and down or scroll left and right in the document.

Status Bar Appears at the bottom of the program window and 
displays information about the document (number 
of pages, number of words, etc.). The tools on the 
right side of the Status bar can be used to display the 
document in a variety of views and to change the 
zoom level.

ACTIVITY 1

Name the parts of the Word window

1.	 Appears at the top of the program window and displays 
the name of the document and the program.
_________________________

2.	 Appears on the left of the Title bar and contains frequently used commands that are ondependent of the tab 
displayed on the ribbon.
_________________________

3.	 Extends across the top of the program window, directly below the Title bar and consists of a set of tabs – each 
of which contains groups of related commands.
_________________________

4.	 A blinking vertical line that indicates where text or object will be inserted.
_________________________

5.	 Appears below the Ribbon and displays the content of the document.
_________________________

6.	 Appears along the right side and bottom of the document window and enable you to scroll through the 
document.
_________________________

7.	 Appears at the bottom of the program window and displays information about the document (number of 
pages, number of words, etc. ). 
_________________________

1.3 THE BACKSTAGE VIEW: 

The File tab (the first tab on the Ribbon) is used to display the Backstage view which contains all the commands 
related to managing files and customizing the program. It provides an easy way to create, open, save, print, share, 
export, and close files; view and update file properties; set permissions; set program options; and more. Commands 
available in the Backstage view are organized into pages which you can display by clicking the page tabs in the left 
pane.

Typing =rand(4,10) will create 4 paragraphs 
of text content each made up of 10 sentences.
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To display the Backstage view:

Click the File tab on the Ribbon (see Figure ).

To exit the Backstage view:

Click the Back button in the upper-left corner of the Backstage view Or, press the Esc key.

1.4 CREATING DOCUMENTS
When you start Word 2013 and click Blank document on the Start screen, a new document opens in the program 
window, ready for you to enter your content. You can also create a new document while Word 2013 is running. 
Each new document displays a default name (such as Document1, Document2, and so on) on the Title bar until 
you save it with a more meaningful name. The cursor, a blinking vertical line in the upper-left corner of the page, 
shows where the next character you type will appear. When the cursor reaches the right margin, the word you are 
typing automatically moves to the next line. This feature is called Word Wrap.  Pressing the Enter key starts a new 
paragraph.

Creating a New Document:

1. Click the File tab, and then click New. 
The New page of the Backstage view opens, 
displaying thumbnails of the available tem-
plates.

2. In the right pane, click Blank document. 
A new, blank document opens in a new win-
dow. You can also create a new document by 
pressing Ctrl+N.

New Page of the Backstage View
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1.5 SAVING A DOCUMENT
After creating a document, you can save it on your computer. Use the Save As command when you save a document 
for the first time or if you want to save a copy of a document in a different location, with a different file name, or 
in a different file format.

Use the Save command to save changes to an existing document.

NOTE: Word 2013’s file format has the .docx file extension.
To save a document for the first time:

1. Click the File tab, and then click Save As. The Save As page of the Backstage view opens.
2. Click Computer in the center pane, and then click the Browse button or a recent folder in the right pane.

      3.	 In the Save As dialog box, select a location to save the file, type a name in the File name box, and then 	
	 click the Save button (see Figure below)

NOTE: By default, Word 2013 documents are saved in the Word Document format. To save a document 
in a different format, click the Save as type arrow and select the desired file format from the list.

To save changes to a document Do one of the following:↓

•	 Click the File tab, and then click Save.
•	 On the Quick Access toolbar, click the Save button . 

•	 Press Ctrl+S.

Save As Page of the Backstage View

Save As Dialog
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1.6 CLOSING DOCUMENTS 
When you finish working on a document, you can close it, but keep the program window open to work on 
more documents. If the document contains any unsaved changes, you will be prompted to save the changes 
before closing it.

To close a document without exiting Word:

Click the File tab, and then click Close. Or, press Ctrl+W.

NOTE: When you close a document, Word 2013 automatically bookmarks the location you were last working on. 
When you reopen the document, you can pick up where you left off by clicking the Resume Reading callout that 
appears on the right side of the program window (see Figure 18). The callout changes to a bookmark icon after a 
few seconds (see Figure 19). You can point to the bookmark icon or click it to redisplay the message. Scrolling the 
document makes the callout disappear.

1.7 OPENING DOCUMENT
You can locate and open an existing document from the Start screen when Word 2013 starts or from the Open 
page of the Backstage view. The Start screen and the Open page also display a list of recently used documents which 
you can quickly open by clicking them. Each document opens in its own window, making it easier to work on two 
documents at once.

To open a document:

1.  Click the File tab, and then click Open. Or  press Ctrl+O. The Open page of the Backstage view opens, 
displaying a list of recently used documents in the right pane.

2. If the document you want is in the Recent Documents list, click its name to open it. Otherwise, proceed 
to step 3.

3. Click Computer in the center pane, and then click the Browse button or a recent folder in the right pane.

Bookmark

Open Dialog Box
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1.8 EDITING DOCUMENTS 
Most documents require some editing. After creating a document, you may want to add or remove text, or move 
text from one place to another. This section covers how to perform basic tasks such as selecting, deleting, copying, 
and moving text; and undoing and redoing changes.

Selecting Text

Before you can edit text, you must first select the text that you want to modify. You can use the mouse, the 
keyboard, or the selection area (an invisible area in the document’s left margin) to make a selection. Selected text 
appears highlighted on the screen.

To select text: Do the following:

o	 To select a word, double-click anywhere in the word.

o	 To select a sentence, hold down the Ctrl key and click anywhere in the sentence. 

o	 To select a line, click in the selection area to the left of the line.

o	 To select a paragraph, triple-click anywhere in the paragraph. Or, double-click in the selection area to the 
left of the paragraph.

o	 To select the entire document, triple-click in the selection area. Or, press Ctrl+A.

o	 To select adjacent words, lines, or paragraphs, drag the mouse pointer over the text. Or, click at the beginning 
of the text, and then hold down the Shift key and click at the end of the text.

o	 To select non-adjacent words, lines, or paragraphs, make the first selection, and then hold down the Ctrl key 
and make the second selection.

Deleting Text

You can delete text one character at a time by positioning the cursor, and then pressing the Backspace key to delete 
the character to the left of the cursor or the Delete key to delete the character to the right of the cursor. You can 
also select and delete a word, sentence, paragraph, or block of text.

To delete text: Select the text that you want to delete, and then press the Delete key.

Moving and Copying Text
When editing a document, you may want to duplicate text in another location, or you may want to remove (cut) 
text from its original location and place it in a new location.

NOTE: Cut or copied text is stored on the Clipboard, a temporary storage area. You can 
access it by clicking the dialog box launcher in the Clipboard group on the Home tab of the 
Ribbon (see Figure on the right side)

To move or copy text:

1. Select the text that you want to move or copy.
2. On the Home tab, in the Clipboard group, do one of the following:

To move text, click the Cut       button.  Or, press Ctrl+X.

To copy text, click the Copy       button.  Or, press Ctrl+C.

3. Click in the document where you want to paste the cut or copied text.
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4. On the Home tab, in the Clipboard group, click the Paste        button. Or, press Ctrl+V. 

NOTE: Clicking the arrow on the Paste button displays additional paste options.

1.8 MOVING AROUND IN DOCUMENTS 
To move the insertion point to anywhere in the document either the mouse or the keyboard can be used. To 
move the insertion point with the mouse, the mouse pointer is moved to the required spot and the mouse button 
is clicked. The insertion point jumps to that spot. 
If you open a document that is too long to fit entirely on the screen, you can bring off-screen content into view 
without changing the location of the cursor by using the vertical scroll bar.

● Click the scroll arrows to move up or down by one line.
● Click above or below the scroll box to move up or down.
● Drag the scroll box on the scroll bar to display the part of the document corresponding to the location of the  
    scroll box. 

KEYBOARD SHORTCUTS
To move the insertion point with the keyboard the arrow keys and other key combination can be used. The 
following table gives a list of short cut keys.

Cursor movement Key or keyboard shortcut

Left one character  Left Arrow

Right one character Right Arrow

Down one line Down Arrow

Up one line Up Arrow

Left one word Ctrl+Left Arrow

Right one word Ctrl+Right Arrow

To the beginning of the current line Home

To the end of the current line End

To the beginning of the current document Ctrl+Home

To the end of the current document Ctrl+End

Up one screen Page Up

Down one screen Page Down

To the beginning of the previous page Ctrl+Page Up

To the beginning of the next page Ctrl+Page Down

1. Creating and Saving a Document

•	 Open Microsoft Word 2013.
•	 Create a new blank document.
•	 Type a short paragraph about your favorite hobby.
•	 Save the document to your desktop with the name “Hobby.docx”.
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2. Formatting Text

•	 Change the font of the paragraph to Comic Sans, size 14.
•	 Bold the first sentence.
•	 Italicize the last sentence.
•	 Change the color of the text to blue.

3. Paragraph Formatting

•	 Center align the title “My Hobby” at the top of the document.
•	 Add a double underline to the title.
•	 Set the line spacing of the paragraph to 1.5.

Save the file as “Hobby.docx” on the desktop or as per your instructor’s guidelines.

Tips: -  Use the Ribbon interface to find commands and options.

 BR AIN DEVELOPER 

I. WHICH PART OF THE WORD WINDOW HELPS YOU DO THE 

FOLLOWING?
Column A Column B Ans

1. Move up and down the document a. Document area

2. Know how many words are in the document b. Title bar

3. Know the name of the document currently open c. ESC key

4. Exit Backstage view d. Vertical scroll bar

5. Type text in the document e. File Tab

6.  Vertical blinking line in the document area f. Status bar

7. Do file operations like saving, closing etc. g. Insertion Point

II. FILL IN THE BLANKS
1.	 Shortcut to open a document is _________ 

2.	 Shortcut to close a document is _________

3.	 File extension of word document is_________

4.	 The key which is used to create a paragraph is ___________

5.	 Ctrl + Right Arrow is used to ____________

6.	 The feature of MS-Word that automatically moves the text to the next line when it reaches the right edge of the screen  

	 and is called  ____________________.

Teacher’s Signature
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LEARNING OBJECTIVES 
2.1  Selecting Text

2.2  Moving the Text

2.3  Copying the Text

2.4  Font Group

2.5  Inserting Bulleted or Numbered List

2.6  Insert Word Art

2.7  Paragraph Formatting

INTRODUCTION
Formatting makes the document readable and comprehensible to the person reading it. Text Formatting includes 
making the selected text Bold, Italic, Underline, and changing the Font Style, Size, Colour for changing the 
appearance of text in the word document. Microsoft Word 2013 has a variety of keyboard shortcuts that can help 
you work more efficiently. Here are some frequently used shortcuts:    

2.1 SELECTING TEXT
Even though the document is built by typing one character at a time, while editing and formatting one always 
work with words, lines,paragraphs and sometimes with the whole document. For this purpose the text should be 
selected. For selecting text the mouse or the keyboard can be used.

Selecting Text with Mouse

1. Place the insertion point at the beginning of the text to be selected.

2. The left mouse button should be clicked, held down and dragged across the text to be selected.When the 
intended text is selected, the mouse button should be released. To de-select the wrongly selected text a click should 
be made outside the selected text.

Selecting Text with Keyboard

1. Insertion point is moved to the start of the text to be selected.

2. The Shift key is pressed down and the movement(arrow) keys are used to highlight the required text.When the 
Shift key is released, the text is selected.

SHORTCUTS  FOR SELECTING TEXT

Action to be performed To select what

Shift+Arrow Right Extend selection one character to the right
Shift+Arrow Left Extend selection one character to the left
Shift+End Extend selection to the end of a line

TEXT F ORMATTING
CH

AP
TE
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Shift+Home Extend selection to the beginning of a line
Shift+Arrow Down Extend selection one line down 
Shift+Arrow Up Extend selection one line up
Shift+Page Down Extend selection one screen down 
Shift+Page Up Extend selection one screen up
Ctrl+A Select the Entire document
F8 Turn Extend Mode on: Extend selection without pressing shift key
Ctrl+Shift+f8, and arrow keys Select a vertical block of text in Extended Mode
Shift+F8 Reduce the size of a selection in Extended Mode
Esc Turn extend mode off

2.2 MOVING THE TEXT
The selected text can be easily cut and pasted in the required location. 

1. The text to be moved to a new location is selected.

2. HomeCut is selected or select cut icon  from the Home tab.

3. Place the Insertion point is where the text is to be pasted.

4. HomePaste is selected or select the Paste icon  from the Home tab and paste the text in the new location. 
The text can be pasted in this way either in the same document or in another document also.

2.3 COPYING THE TEXT
1. The text to be copied is selected.

2. HomeCopy is selected or copy icon   from Home tab is clicked.

3. Click in the document where to paste the copied text and then click Paste tool in Clipboard group

ShortCut Keys  For Cut, Copy and Paste

Ctrl+Z Undo the last action
Ctrl+Y Redo the last action
Ctrl+C Copy selected text or object
Ctrl+X Cut selected text or object
Ctrl+V Paste selected text or object

ACTIVITY 1

Type  a paragraph about Nature 

1. Bold a phrase

2. Highlight the phrase “Nature”

3. Italicize and underline a word.

4. Create a duplicate of the Paragraph

5.Cut one of the Paragraph and paste it in another document. Save the new document as “Nature”.
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2.4 FONT GROUP
The Font group includes various commands such as a Font, Font Size, Grow Font, Shrink Font, Clear Formatting, 
Bold, Italic, Underline, Strike Through, Subscript, Superscript, Change Case, Text highlight Color and Font Color. 
Selecting the related icon and apply it on a selected text.

The shortcut keys used for doing any one of the above action is listed in the table. Select the required text or 
Paragraph.

Display the Font dialog. Ctrl+D

Ctrl+Shift+F Ctrl+Shift+Right angle bracket (>)

Increase the font size. Ctrl+Shift+Right angle bracket (>)

Decrease the font size. Ctrl+Shift+Left angle bracket (<)

Increase the font size by 1 point. Ctrl+Right bracket (])

Decrease the font size by 1 point. Ctrl+Left bracket ([)

Switch the text between upper case, lower case, and title case. Shift+F3

Change the text to all upper case. Ctrl+Shift+A

Hide the selected text. Ctrl+Shift+H

Apply bold formatting. Ctrl+B

Apply underline formatting. Ctrl+U

Apply underline formatting to the words, but not the spaces. Ctrl+Shift+W

Apply double-underline formatting. Ctrl+Shift+D

Apply italics formatting. Ctrl+I
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Apply small caps formatting. Ctrl+Shift+K

Apply subscript formatting. Ctrl+Equal sign (=)

Apply superscript formatting. Ctrl+Shift+Plus sign (+)

ACTIVITY 2

1.Open the document “Nature”

2.Select the entire document

3. Select the Comic Sans MS font

4. Select  16 point font size.

5. Type H2+O2=2H20  (Format the 2 using subscrpt)

6.Type (a+b)2=a2+b2+2ab   (Format the 2 using superscrpt)

7.Increase the Font size of the above content

8.Apply different colours for each paragraph.

9. Type “The good man is the friend of all living things”

10. Under line important words of the above document. 

2.5 INSERTING BULLETED OR NUMBERED LIST
When you type 1, a period, a space, and some text, then press Enter, Word automatically starts a numbered list for you. Type 
* and a space before your text, and Word makes a bulleted list. Ctrl+Shift+L is also used to create a bulleted list.

Create a Bulleted or numbered list 

Select the text you want to apply a bullet or list. Go to Home tab and select  Bullets or Numbering.You can find different 
bullet styles and numbering formats by clicking the down arrow next to Bullets or Numbering.
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2.7 INSERT WORDART
WordArt is a quick way to make text stand out with special effects.
		  1. On the Insert tab, Click the Insert WordArt button. 
		  2. In the WordArt gallery, Click the  WordArt  style you prefer.

	 3. Type the text.For example “Happy Birthday” and click outside.

	 4. Customize your text by selecting the various options from the drawing tool to get the following result.

 

ACTIVITY 3
1. Make a Microsoft Word document. In it, type your name in 5 different Word Art types with different 
sizes, colors, slants/rotates.
2. List any five fruit names using bullets
3. Using numbering list list out any five of your favorite games.

2.8 PARAGRAPH FORMATTING
A paragraph in Word is any text that ends with pressing 
the Enter key. Paragraph formatting lets you control the 
appearance of individual paragraphs. For example, you can 
change 

	 • the alignment of text from left, center, right or 
justify.

	 • the spacing between lines form single to double. You  
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	    can change it to other available options.

	 •indent paragraphs, number them, or add borders and shading to them.

Paragraph formatting is applied to an entire paragraph. All formatting for a paragraph is stored in the paragraph 
mark and carried to the next paragraph when you press the Enter key.

Select the required icon from the Paragraph grouping under the Home tab .

The shortcutkeys used for the above actions are

Ctrl+L Align the text to the left.

Ctrl+R Align the text to the right.

Ctrl+J Justify the text.

Ctrl+E Center the text.

Ctrl+M Indents the paragraph.

Ctrl+Shift+M Remove the indent from a paragraph

Ctrl+5 1.5  line spacing

Ctrl+2 Double line spacing

Ctrl+1 Single line spacing

ACTIVITY 4

1. 	 Type a paragraph in a word document.Give an appropriate heading for the paragraph.

2.	 Center the heading.

3.	 Align the paragraphto the right and give double line spacing.

4.	 Indent the first line of the paragraph.
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 BR AIN DEVELOPER 

I. CHOOSE THE BEST ANSWER
1. What is the smallest and largest font size available in Font Size tool on formatting toolbar?
(A) 8 and 72		  (B)  8 and 68		  (C)  6 and 72		  (D) 6 and 68

2. A character that is raised and smaller above the baseline is known as
(A)  Raised     (B) Outlined	 (C)Capscript	 (D)Superscript

3. The key that should be pressed to start a new paragraph is
(A) Down Arrow Key  (B) Enter Key   (C) Shift + Enter  (D) Ctrl + Enter

4.The function of Ctrl + B in Ms-Word is
 (A)	 It converts selected text into the next larger size of the same font
 (B)	 It adds a line break to the document
 (C)	 It makes the selected text bold
 (D)	 It applies Italic formatting to the selected text

5.What is the function of CTRL+R in MS-Word
    (A)	 Open the Print dialog box
    (B)	 Update the current Web page
    (C)	 Close the current window
    (D)	 None of these

II. ANSWER IN ONE LINE

(A)	 Name the common change made for a paragraph.

(B)	 What is the use of Ctrl+E?

(C)	 How will you remove an indent in a paragraph?

(D)	 What are the different ways to to select a text?

(E)	Which tool helps to customize the wordart?

(F)	Which option allows you to lock certain rows or columns in place while scrolling through a large worksheet?

i.	 View Options

ii.	 Split Panes

iii.	Freeze Panes

iv.	 Lock Panes
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Teacher’s Signature

G.	What is filtering in Excel?

i.	 arranging data into categories

ii.	 removing blank cells from a worksheet

iii.	sorting data alphabetically

iv.	 viewing data based on certain criteria
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LEARNING OBJECTIVES 
3.1 Introduction

3.2 Inserting a Picture

3.3 Picture Formatting

3.1 INTRODUCTION
Adding pictures to your document can be a great way to illustrate important information to existing text. Used 
in moderation, pictures can improve the overall appearance of your document, convey our messages, thoughts, 
ideas in a very simple and a beautiful way.  Moreover Pictures attract the audience to understand our topic very 
easily. 

MS Word has a feature that allows us to insert an image or picture file directly from our computer into our projects. 
You’ll be able to edit the pictures inside and also customize their look. So we should use different types of pictures 
in our document.

3.2 INSERTING A PICTURE

1.	 Select the insert option from the navigation menu. 
2.	 Now select the picture option as shown:
3.	 A insert picture from dialog box will open.
4.	 There are two ways to insert a picture: 
•	 This Device – You can insert a picture file from your computer.
•	 Online Pictures – You can also insert pictures from online sites.

Method 1 – This Device↓

4.a) Select This Device option as shown:
A insert picture dialog box will appear

•	 Select the drive or folder from the left panel menu where your  
		  pictures are saved as shown:
•	 Next select the picture/image you want to insert in your document  

	and click on the insert button.
•	Finally, pictures/images available on your computer is added to  
	your document.

MS  WO RD – PI C TU RES
CH

AP
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Method 2 – Online Pictures↓

4.b) Select  Online Pictures…  option as 
shown:
•	 An online pictures dialog box will open 
where you can search a variety of online 
pictures.
•	 Search the picture/

image name in the search bar.
•	 Select the picture and then click on the  insert  button as 
shown.
Finally, the selected online image will be added to your document.

3.3 PICTURE FORMATTING
•	 Now you can set or resize the size of your picture according to your requirement 
using the dot button.

•	 To give styles to the picture 
click on the format option from 
the navigation menu. Select 
picture style as per your choice. 
Eg.↓    

 WRAP TEXT AROUND THE PICTURE:
Notice that wherever the image is placed, the line spacing dramatically increases 
to fit the size of the picture. This is because images are treated as an inline text 
character. In other words, Word treats the image like it would treat any word or 
letter of text. You can change this by applying a text wrap. Text wrap causes all 
of the text to wrap around the image so that the image does not interfere with 
line spacing.

There are a couple of ways to get to the text wrap options and apply a text wrap.

Method 1: Quick Apply
Click the box to the right of the image with a rainbow-shaped icon.

Method 2: Format Tab
When you click on the image, the Format tab will appear in the ribbon. From 
the Format tab, you can choose Warp Text.

 To resize an image, click and drag one of the corner sizing handles. The image 
will change size while keeping the same proportions. If you want to stretch it 
horizontally or vertically, you can use the side sizing handles.
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Text Wrap Options
Regardless of which method you use, the text wrap options are the same. The text wrap you will probably use the 
most is the square text wrap, but there are other text wraps too.
•	 Square—Text wraps around the image in a square shape
•	 Tight/Through—Text wraps around image, regardless of what shape the image is.  This text wrap works 
best with images that have no background.
•	 Top and Bottom—Text stops when it hits the top of the image and continues at the bottom of the image; 
no text is to the left or right of the image
•	 Behind text—Image is behind text. Text will cover image.
•	 In front of text—Image is in front of text. Text behind the image is not visible.

ACTIVITY 1:
1.	 Open a new document and save it as kitewithoutthread.docx.Type the  title as “Kite without thread” and  
	 enter the following text.
	 “Once a father and son went to the kite flying festival. The young son  
	 became very happy seeing the sky filled with colorful kites. He too  
	 asked his father to get him a kite and a thread with a roller so he can  
	 fly a kite too. So, the father went to the shop at the park where the  
	 festival was being held. He purchased kites and a roll of thread for his  
	 son.”
2.	 Insert the picture named BoyFatherKite.jpeg below the title of the story
3.	 Resize the picture so that it looks small.
4.	 Center the picture using the alignment option on the Home tab.
5.	 Rotate the picture a little to the left by clicking on the green rotate handle and dragging it to the left a little.
6.	 Square wrap the text around the picture
7.	 Change the wrapping to In Line with text
8.	 Apply an orange border with thickness of 3 pts using Picture border- weight. Give a dotted effect to the  
	 border using Dashes.
9.	 Apply the Drop Shadow Reflection effect from picture effect.
10.	 Crop the picture a little from the bottom crop icon. 

 BR AIN DEVELOPER 
1.	 Create a new Word document.

2.	 Insert a Picture/image.

3.	 Insert a picture from a file into the document.

4.	 Resize the picture.

5.	 Change the text wrapping setting to In Front of Text.

Teacher’s Signature

Please use the following url 
to download the picture file

https://tinyurl.com/father-boy-kite
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LEARNING OBJECTIVES 
4.1 INTRODUCTION

4.2 INSERT A SMARTART

4.3 ADDING TEXT TO A SMARTART GRAPHIC

4.4 MODIFYING THE SMARTART

4.5 FORMATTING SMARTART

4.1 INTRODUCTION
SmartArt is a feature that allows to communicate information with graphics instead of text, such as organizational 
charts, process flows, and hierarchical displays. Let’s learn how to use SmartArt in MS Word 2013.

4.2 INSERT A SMARTART
1. Place the insertion point in the document where you want 
the Smart Art to appear. 

2. From Insert tab select SmartArt in the Illustrations group. 
3. A dialog box opens, displaying categories of SmartArt 
on the left, styles of SmartArt graphics in the middle, 
and a preview and description of the selected SmartArt 
on the right, choose the desired SmartArt graphic, then 
click OK.

	 4. The SmartArt graphic will appear in your 	 
	 document. 

4.3 ADDING TEXT TO A SMARTART GRAPHIC
Select the SmartArt graphic to select it. The SmartArt task pane will 
appear to the left.

1.	 Enter text next to each bullet in the task pane. The text will appear 
in the graphic and will resize to fit inside the shape.

2.	 To add a new shape, press Enter. A new bullet will appear in the 
task pane, and a new shape will appear in the graphic. 

3.	 You can delete any bullets you’re not using to remove the shapes.

MS WORD – SMARTART
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Note: You can also add text by clicking on the desired shape and then typing. This 
works well if you only need to add text to a few shapes. However, for more complex 
SmartArt graphics, working in the task pane is often faster.
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4.4 MODIFYING THE SMARTART
4.4 a. Adding a Shape:

1.	 Select the SmartArt graphic, then click the Design tab on the right side of the Ribbon.

2.	 Select the shape before or after the shape where you want to 
insert the new shape.

3.	 Click the Add Shape command in the Graphics group. A drop-down 
menu will appear.

4.   Select Add Shape Before or Add Shape After to add a shape on  
  the same level as the selected shape. Select Add Shape  Above or Add 
Shape Below to add a shape one level above or below the selected 
shape.

5.   The new shape will get added.

4.4 b. Promote or Demote shapes:

1.	 Select the SmartArt graphic, then click the Design tab on the right side of the Ribbon.

2.	 Select the shape you would like to promote or demote. In our example, we’ll demote a shape.
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3.	 To move the shape to a higher level, click the Promote command in the Create Graphic group. To 
move it to a lower level, click Demote. 

4.	 The shape will move one level higher or lower.

4.5 FORMATTING APPEARANCE
4.4 a. Changing the Appearance

1.	  Select the graphic. The Design and Format tabs appear on the Ribbon.

2. 	 Click the Design tab. In the SmartArt Styles group, click the More drop-down arrow to view all of the styles.

3.  	Hover your mouse over each style to see a preview and select the desired one.

4.6 CHANGE COLOUR SCHEME OF THE SMARTART
1. 	 Select the graphic. The Design and Format tabs appear on the 

Ribbon.

2. 	 Select the Design tab.

3. 	 Click the Change Colors command. A drop-down menu appears, 
showing various colour schemes.

4. 	 Select the desired color scheme.

Note: You can also demote and promote shapes from within the task pane. With the insertion point in 
the task pane, press the Tab key to demote a shape. Press the Backspace key (or Shift+Tab) to promote 
a shape. It’s a lot like creating an outline with a multilevel list. 
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ACTIVITY 1

1.	 Create a new document.

2.	 Insert a SmartArt graphic to depict the “Food Groups”.

3.	 Enter text into the graphic.

4.	 Change the SmartArt style.

5. 	 Change the colour scheme.

 BR AIN DEVELOPER 

I. CHOOSE THE BEST ANSWER

1.	 Under what grouping of commands will you find the SmartArt command?

	 (a)	 Text   

	 (b) 	 Illustrations  

	 (c) 	 Paragraph 

	 (d)	 Design

2.	 Where do you go to add more shapes to your SmartArt Graphic?

       (a)	 SmartArt Tools>Design>Create Graphic Grouping>Add Shape 

       (b) 	 SmartArt Tools>Format>Add Shape icon

       (c) 	 Insert>SmartArt>Add Shape icon

       (d) 	 Design>Tools>Add Shape icon

II. ANSWER THE FOLLOWING

1. 	 What is the use of Smartart?

2. 	 Which command is used to create a graphic group?

Teacher’s Signature
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CUSTOMIZING HEADER, 
F OOTER, ADDING PAGE 

NUMBERS
LEARNING OBJECTIVES 
5.1 introduction

5.2 Adding a header or footer

5.3 Adding Page Numbers

5.4 Use Preset Headers or Footers

5.5 Different First Page Header/Footer

5.1 INTRODUCTION
A header is text that is placed at the top of a page, while a footer is placed at the bottom, or foot, of a page. 
Typically these areas are used for inserting document information, such as the name of the document, the chapter 
heading, page numbers, creation date and the like. This information is repeated on each page and thus enables the 
reader to easily navigate the document.
Each and every document contains header and footer areas, but the areas are only visible when they contain 
information. To enter information into a header or footer, you need to activate it. Headers and footers are only 
visible in Print Layout view and Print Preview. To indicate when the headers and footers are not active, the 
information contained within them appears greyed out or faded.
Microsoft Word contains a number of built-in and pre-formatted headers and footers that enable you to add a 
stylish header and/or footer to your document. These headers and footers can be inserted and then edited to suit 
your needs. For instance, 
you might need to insert 
a company logo.

5.2 ADDING  A HEADER OR FOOTER
In our example, we want to display our schools name at the top of each page, so we’ll place it in the header.

Double-click anywhere on the top or bottom margin of your document to activate the header.  In our example, 
we’ll double-click the top margin.

1.	 The header or footer tools - Design tab will appear on the right side of the Ribbon and an insertion point will 
appear in the header or footer.

2.	 Type the desired information into the header or footer. In our example, we’ll type our school name.
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3.	 When you’re finished, click Close Header and Footer. Alternatively, 
you can press the Esc key.

4.	 The Header/Footer is inserted.

5.3 ADDING PAGE NUMBERS

Word can automatically label each page with a page number and place it in  header, footer, or side margin. When 
you need to number some pages differently, Word allows you to restart page numbering.

In our example, we’ll add page numbering to our document’s footer.

1.	 Double-click anywhere on the header or footer to unlock it. If you don’t already have a header or footer, 
you can double-click near the top or bottom of the page. 
The Design tab will appear on the right side of the Ribbon.

2.	 Click the Page Number command. In the menu that appears, 
hover the mouse over Current Position and select the 
desired page numbering style.

After you close the header or footer, it will be visible, but it will be locked. Simply 
double-click a header or footer to unlock it, which will allow you to edit it.
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3.	 Page numbering will appear.

4.	 Use the tools 0f the Home tab to change the font, font size, and alignment of the page numbers.
5.	 When you’re finished, press the Esc key. The page numbering will be formatted.

5.4 USE PRESET HEADERS OR FOOTERS:
•	 Go to the Insert tab.
•	 Click Header or Footer (depending on what you want to add).
•	 Choose a preset header or footer design.
•	 Edit the content (e.g., title, author, date) by clicking the placeholders.
•	 Close the header or footer when done.
	

5.5 DIFFERENT FIRST PAGE HEADER/FOOTER:
•	 Sometimes you might want the first page to have a different header/footer (e.g., cover page without 

numbering).
•	 Check the box for “Different First Page” in the Design tab to hide the header/footer on the first page

Remember, you can always double-click a header or footer to edit it, and the Design  tab provides additional 
options for customization.

ACTIVITY

Rashmi’s teacher has asked her to create MS Word document consisting of 20 pages.  She has to mention 
her name and roll number on every page as header and footer.  She has to mention the page number also in 
every page of the document except the first page.  Imagine you are Rashmi and complete the task.
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 BR AIN DEVELOPER 

I. FILL IN THE BLANK

1.	 The area at the top margin of the document is called ________

2.	 Header option comes under the group  __________

3.	 The Design tab appears in  ____________

II. CHOOSE THE CORRECT ANSWER:
1.	 By default, on which page the header or the footer is printed?

i.	 On first page
ii.	 On alternate page

iii.	 On every page
iv.	 None of the above

2.	 To view headers and footers, you must switch to
i.	 Normal view

ii.	 Print layout view
iii.	 Print preview mode
iv.	 Both B and C

3.	 Insert Date, Format Page Number, and Insert AutoText are buttons on the ________ toolbar.
i.	 Formatting

ii.	 Header and Footer
iii.	 Standard
iv.	 Edit

III. CHALLENGE!
1. Create a new Word document.
2. Add your name to the header. 
3. Add today’s date to the header.
4. Try adding a page number to the footer. 
5. Try restarting the page numbering from 5.

Teacher’s Signature
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COLUMN TEXT AND PAGE 
BREAK

LEARNING OBJECTIVES 
6.1 Introduction 

6.2 Format text to appear as multiple columns

6.3 Insert a Column Break

6.4 Insert a Page Break

6.5 Delete a break

6.1 INTRODUCTION
By default, MS Word creates text in a single column that runs from one margin to the other. We can format text 
in multiple columns, which are also known as “newspaper columns.” Text usually fills columns in the order in 
which the columns appear breaking from one column to another only after a column is filled. If we want more 
control over where columns breaks, we can insert a column break at a specific location, or we can adjust all columns 
to have equal lengths. When we use multiple columns, text flows continuously from the bottom of one column to 
the top of the next column as illustrated below. 

6.2 FORMAT TEXT TO APPEAR AS MULTIPLE COLUMNS
1.	 Select the text you want to format. Click the Layout tab.
2.	 Click the Columns command in the Page Setup group. A drop-down menu 

will appear.
3.	 Select the number of columns you want to insert. The text will be formatted 

into that number of columns.
To Remove the columns, click the Columns command from the Layout tab and 
select One from the Columns Menu  for the number of columns.
The text will shift to  reflect the column break.

The available column types in this Columns menu are:
1.	 One: This keeps only one column in your document, which equates to not  
	 adding any columns at all.
2.	 Two: Select this option to add two equal-sized columns to your document.
3.	 Three: This option adds three columns to your document.
4.	 Left: This adds one column to the left of your document.
5.	 Right: This adds one column to the right of your document.
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By default, MS Word creates text in 
a single column that runs from one 
margin to the other. We can format 
text in multiple columns, which 
are also known as “Newspaper 
Columns.” Text usually fills columns 
in the order in which the columns 
appear breaking from one column to 

another only after a column is filled. 
If we want more control over where 
columns break, we can insert a 
column break at a specific location, 
or we can adjust all columns to have 
equal lengths. When we use multiple 
columns, text flows continuously 
from the bottom of one column to 

the top of the next column.   
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6.3 INSERT A COLUMN BREAK
1.	 Place the insertion point where you want to add the column break.
2.	 Click the Page Layout tab.
3.	 Click the Breaks command in the Page Setup group. A drop-down menu will 
appear.
4.	 Select Column from the list of break types.
The “Columns” menu(picture above) displays various column types you can add to 
your document. Each column type has a preview beside it, so you know how that 
column will look in your document.

The text will shift to reflect the column break

ACT IVIT Y  1

1. Open an existing Word document. Select the text you want to format into columns.

2. Format the selected text into two columns.

3. Add a column break.

6.4 INSERT A PAGE BREAK
When a user is working in MS Word and gets to the end of the page then MS-Word automatically starts a new page 
to work on. But sometimes a user needs to control where to end a page and where to begin a new page. So, this is 
the situation where we need to use page breaks or insert a page break. Steps to insert  a page break are given below.
Steps to follow for inserting a page break at start: 
Step 1: Open MS Word on your PC.
Step 2: Open the file or document you want to make changes to.
Step 3: Now, choose from where you want to start a new page (or where you 
want to insert a page break). So, put the cursor there.
Step 4: On the  Insert  tab, click the  Page Break command.  Alternatively, 
you can press  Ctrl +  Enter on your keyboard.

The page break will be applied to the document, and the text will move to the next 
page.

6.5 DELETE A BREAK:

1.	 From the Home tab, click the Show/Hide ¶ command in paragraph 
group.

2.	 Press the Backspace or Delete key to delete the break.

Note:  By default, breaks are hidden. If you
want to show the breaks in your document, 
click the Show/Hide command.
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ACT IVIT Y
1.	 Open a MS word document.  Write the name of your school as the header. Type your name, class and 

section as the footer. Convert part of the text to two columns text. 
2.	 Again open a new Word document. Using Page Break tool create new pages. Show Your school name 

as Header and Page number as footer.

 BR AIN DEVELOPER 

I MATCH THE FOLLOWING

	 1.   Page setup	 a. 	 1

 	 2.   Delete a Break	 b. 	 Page break

 	 3.  Column 	 c. 	 Show/Hide

II FILL IN THE BLANK

1.	 ------ tells the printing device where to end the current page.

2.	 Show/Hide option is present in ------ tab.

3.	 There are -------- number of column setting is available.

Teacher’s Signature
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INSERTING A CHART

LEARNING OBJECTIVES
7.1 Introduction		

7.2 Inserting charts

7.3 Changing the Layout

7.4 Modifying Charts Elements

7.1 INTRODUCTION
In Word charts are ideal for presenting information graphically. Using charts in MS Word has many advantages. 
Charts are helpful for saving time. Instead of reading tables or spreadsheets of numbers, you can use charts that 

show the same info quickly and easily. They can be used to 
condense a lot of data into one visual. 

Word offers a number of different types of charts like – Pie 
charts, Column charts, Bar charts…etc. that you can choose 
from. Choose the one that best fits your data. These charts 
can be customized to add titles/labels, adjust colors and a lot 
other features to make it look more attractive and effective

7.2 INSERTING A CHART
1.	 Click where you want to insert the chart.
2.	 Click the Insert tab.
3.	 Click the Chart button in the Illustrations group.

The Insert Chart dialog box lets you choose from a variety of chart 
types. Some chart types will be better at displaying certain data 
than others.

The most common types of charts are Column, Line, and 
Pie.
o	 Column and Bar charts work well to compare different sets of data against each other.
o	 Line and Area charts are great for showing trends over time.
o	 Pie charts show different categories as parts of a whole.

4.	 Select a chart type.
Each chart type has a few styles to choose from, presenting the data 
differently.

5.	 Select a chart style.
6.	 Click OK.
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Add Chart Data
When a chart is inserted, its spreadsheet will be full of sample data that you should replace with the table data.
Enter your chart data.
As you add rows and columns, the row headers, column headers, 
and data are highlighted by borders.
1.	 To add or remove sections of the data, click and drag any of 

the selection handles in the spreadsheet and what’s included 
in the chart will change.

2.	 Click the spreadsheet window’s Close button when you’re 
done.

To reopen the spreadsheet, select the chart, click the Design tab 
in the Chart Tools ribbon group, and click the Edit Data button.

7.3 CHANGE THE LAYOUT
You can quickly adjust a chart’s layout at any point after you’ve inserted it. Layouts will affect the position of chart 

elements like the title, legend, and data labels.

1.	 With the chart selected, click the Design tab in the Chart 
Tools ribbon group.

2.	 Click the Quick Layout button.

A gallery of available layouts appears, based on the chart’s 
type.

3.	 Select a layout.

The layout is applied.

If you want to change the color or style, use the options in the 
Chart Styles group.

7.4 MODIFY CHART ELEMENTS
Another way to change the chart layout is to use the chart tool shortcuts to edit the active chart elements.

1.	 With the chart selected, click the  
Chart Elements button.

	 Different chart types contain different chart elements.  
	 Depending on the chart type, you can adjust gridlines,  
	 titles, legends, and data or axis labels.

2.	 Click the check box next to the element you want to 
toggle on or off.

Each element can also be customized further. You can 
set the position of elements such as the title or legend, 
or toggle subsets of specific elements, such as horizontal or vertical gridlines.

3.	 Click the list arrow next to a chart element and select an option.

You can continue to set up chart elements in this way until the chart appears exactly how you want it. You can also 
insert or modify chart elements by clicking the Design tab in the Chart Tools ribbon group, then clicking Add 
Chart Element.
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 BR AIN DEVELOPER 

I FILL IN THE BLANK

1. A graphical representation of data is known as ------. 

2. DataEdit Data. Is available in -------- tab

3. Right click on the chart and select Format Axis -------- window appears

Teacher’s Signature

ACT IVIT Y 

Create a student marks table of 5 records. In the same document create a Bar chart. Include all the chart 
elements and format it.

THE CHART ELEMENTS
1.	 The Chart Title should clearly describe what the chart is illustrating.
2.	 The Vertical Axis (also known as the y axis) is the vertical part of the chart. The vertical axis measures 

the value of the columns. 
3.	 The Horizontal Axis (also known as the x axis) is the horizontal part of the chart. The horizontal axis 

identifies the categories in the chart.
4.	 The Data Series consists of the related data points in a chart. In this example, as we can see in the 

legend, the yellow columns represent net sales in February.
5.	 The Legend identifies which data series each color on the chart represents. In this example, the legend 
identifies the different months in the chart.
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WORKING WITH HYPERLINKS

LEARNING OBJECTIVES
8.1 INTRODUCTION

8.2 Creating a Hyperlink to a Webpage.

8.3 Creating a Hyperlink to a Section in the same document:

8.1 INTRODUCTION
Hyperlinks are the backbone of the internet. In a world where digital documents are the norm, knowing how to 
insert a hyperlink in Microsoft Word is an essential skill. Whether you’re a student preparing a research paper, a 
professional creating a report, or just someone who wants to link to a funny cat video in an email, this skill is for 
you.

Hyperlinks in Word not only enhance the usability of your document but also make it interactive and professional-
looking. They can link to external websites, email addresses, different parts of the same document, or even other 
files on your computer. Plus, they’re a huge time-saver for your readers. A hyperlink is a word, phrase, or image 
that you can click on to jump to a new document, or to a webpage, etc. 
Hyperlinks are often blue and underlined, Hyperlink objects do not change color. When you move the cursor 
over a hyperlink(text or image), the arrow should change to a small hand pointing at the link and when you 
click it, a new page is opened or a new place in the current page will open.

8.2 HYPERLINK
1.	 Select the text you want to format as a hyperlink.

2.	  Select the Insert tab, then click the Hyperlink command.

3.	 The Insert Hyperlink dialog box will appear. Using the options on the left side, you can choose 
to link to a file, webpage, email address, document, or a place in the current document.

4.	 The selected text will appear in the Text to display: field at the top. You can change this text 
if you want.

5.	 In the Address: field, type the address you want to link to, then click OK.
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6.	 The text will then be formatted as a hyperlink.

NOTE: In MS Word, hyperlinks are not clickable. To make it clickable, you must 
press and hold the Ctrl Key before you click on the link.
7.	 To remove a hyperlink, right-click the hyperlink and select Remove Hyperlink from 
the menu that appears.

8.3 CREATING A HYPERLINK TO A SECTION IN THE SAME DOCUMENT:
This makes sense if your content is very long and links are used to connect to another section within the same 
document. This way, you can add a link that users can click to jump right to that particular section instead of 
scrolling all the way down. A clear example is the hyperlinks in Table of Contents that refer you to another Chapter 
of the same document.

If this is our goal, then let’s get started:
•	 First, mark the section in your document where you want the link to point 
by bookmarking it.
Lets see how to bookmark the third chapter in a book (chapter 3) so that our link 
will point to that page.
•	 Place your cursor at where you want to insert the bookmark:
Go to the Insert tab, in the Links group, click on Bookmark.
•	 In the Bookmark window, type the name of your bookmark in the text box that is labeled as “Bookmark 
name:”- Here we have called it Chapter 3

•	 Now, click on the Add button to add the bookmark.
•	 Note that the bookmark name must begin with a letter, but can include letters. It must not also include 
any space.
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After you insert the bookmark with the above instructions, then 
you can now create a hyperlink that points to that bookmarked 
location in the same document.
The remaining steps below will now show you how to add a link to 
the bookmarked section in the same document.

•	 Highlight the text you want to use for the link. This should 
be the text that the user will click to jump to the specified 
location. Use text that gives readers clear information about 
where the link points to.

•	 Right-click on the selected text and then click on Link from the 
shortcut menu. Alternatively, press Ctrl+K to display the Insert 
Link dialog.

1.	 Click to select “Place in This Document” from 
the list of “Link To” buttons.

Word will display the list of all bookmarks and headings in 
the box.

2.	 Identify and select the Bookmark you just 
created (which is Chapter3 in our case).

3.	 Then Click OK.
After you hit the OK button, a hyperlink will be created to 
the text you selected for the link.

NOTE: In MS Word,  hyperlinks  are not clickable. To 
make it clickable, you must press and hold the Ctrl Key before you click on the link. 

1. 	Create a new document.

2. 	Type some text, and turn a word or phrase into a hyperlink that links to c:\My Documents\Fun.docx  
(Fun.docx must already exist)

3. 	Test the hyperlink by clicking it. The document Fun.docx should open.

4. 	Remove the hyperlink you just created.

 BR AIN DEVELOPER 

I ANSWER IN A LINE

1.	 What is a Hyper link?

2.	 What is the use of hyper link

3.	 Write the command to create a hyper link

4.	 Write the command to remove a hyperlink

Teacher’s Signature
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MS WORD – WORKING WITH  
TABLES (BASIC TABLE CREATION)

9.1 INTRODUCTION
Tables are a handy tool for organizing data, making data calculations using formulas, displaying information in 
an eye-catching way, or even creating visually appealing charts and diagrams to help break up long paragraphs of 
content.

9.2 CREATING A TABLE
There are seven way by which a table can be inserted in a Word 
document. Two commonly used methods are discussed here.
Create a Table with Graphic Grid:-
This is one of the simplest ways of creating a Microsoft Word 
table. 

1. Go to the Insert tab on the ribbon and click the Table button.
2. When the Insert Table dialog box opens, it’ll show a basic 
grid pattern and menu options below it.
3. With the cursor, select the first grid cell and slide it down 
to select the number of columns and rows you want. As an 
example, choose six columns and four rows.

Create a Table with the Insert Function:-
1. Go to Insert, then click on Table.
2. Select Insert Table from the menu just below the grid.
3. A dialog box will appear where you can enter the number 
of rows and columns you want in your table. Once there’s a 
table in your document, you’ll notice two new tabs on the 
ribbon: Table Design and Layout. You can use these tabs to 
modify and format the table.

9.3 CUSTOMIZE A TABLE 
Table Design and Layout tabs are filled with helpful table tools you can use to format tables.

1. Use Table Design to format your table and change its looks. Here you’ll find tools for shading, painting 
borders, and setting their line thickness, style, and color. You can also select one of the many offered table 
styles.
2. In the Layout tab, you’ll find tools to add or remove cells, rows, and columns, merge cells, split them, or 
split the whole table into several ones. You’ll also use this tab to set other table properties, such as the table’s 
dimensions, or to align the text.

9.4	 INSERT OR REMOVE COLUMNS AND ROWS
There are a number of ways by which new rows and columns can be inserted in a table. The most common method 
to inert columns and rows is mentioned here. 
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To add a single column or a row is simple:
1. Place your cursor on top of the row or on the left side of the column until a plus sign appears
2.	 Click this plus sign to add a new column or row.

To insert multiple rows and columns:
1. Select the same number of already existing rows or columns (if you want to add two columns, select two 
existing ones).
2. Right-click, then go to the Insert menu and select to insert columns to the left or right and rows above or 
below.

9.5	 REMOVE COLUMNS OR ROWS
To delete rows or columns, select them, right-click, and select 
Delete rows (or columns).

9.6	 APPLY A TABLE STYLE:
 
Microsoft Word has many table styles to offer, and you can choose one to make your table look professional. You 
can also do this to skip adding border style and shading.

1. Select the table and go to the Table Design tab.
2. Locate the Table Style box at the top of the window, and use the up and down arrows, or the “More” 
arrow, to browse the gallery.



40

3. If you place your cursor over a specific style, you’ll see its preview on your table.
4. Click on the selected style to apply it to your table.

1.	 The border will appear around the selected cells.

 BRAIN DEVELOPER 

I) ANSWER THE FOLLOWING

1.	 Intersection of row and column is called _______________.

2.	 To move forward one cell press  ______________ .

3.	 To move backward through a cell press ________________ .

4.	 By default each cell consist of _________________ . 

Teacher’s Signature

ACTIVITY

1.	 Open an existing Word document. 

2.	 Create your time table

3.	 Apply a table style, and experiment with the table style options

4.	 Delete a row from the table.

5.	 Insert a blank table with five rows and four columns.

6.	 Add borders to the blank table.
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MS WORD – MAIL 
MERGE WIZARD

LEARNING OBJECTIVES
10.1 Introduction

10.2 How Does Mail Merge Work? 

10.3 Starting the Mail Merge 

10.4 Starting the Mail Merge Wizard

10.1 INTRODUCTION:
Mail Merge is a very handy feature in Word which allows you to personalize and send the same letter to large 
number of people with ease. Instead of having to type each address and name as you go, Mail Merge inserts this 
variable information automatically so all you have to do is print the letters and put them in an envelope! You can 
also create emails, envelopes, labels or a directory using the Mail Merge feature in MS Word.
What Is Mail Merge? 
The mail merge process is where you merge variable data (content that will change from letter to letter) with 
consistent data (content that will be the same in each document). For example, you may want to send a birthday 
invite to all your friends. The message in each invite will be the samevit. This message to invite is the consistent 
data because it will be the same in each letter. The names and email address of each friend (or recipient) are the 
variable data because no two invites will have exactly the same name and address. 

Typing these invites individually would take quite a long time and would be a very boring and tedious job!

10.2 HOW DOES MAIL MERGE WORK? 
•	 For the mail merge to work, you must have two documents which are known in Word as the recipient  
	 list (contains the variable data) and the starting document (contains the consistent data). 

•	 The recipient list comprises the contact details for each person who will receive the mail merge  
	 document. This list must be set out in a table or some other tabular layout where each recipient occupies  
	 a row in the table and each item of data, such as their title and first name, is stored in separate columns  
	 in the table. 

•	 The starting document contains the content you want to send to the recipients. This document is often  
	 a letter or an email message. You can use an existing document, a Word mail merge letter template, or  
	 even create a new document during the mail merge. 

When you have finished merging the recipient list with the starting document, you will have created your mail.

10.3 STARTING THE MAIL MERGE 
There are two ways you can conduct a mail merge using the merge tools in Word. 

a.	 You can use the individual commands on the MAILINGS tab of the ribbon 
b.	 You can use the Step-by-Step Mail Merge Wizard. 

In this chapter we will learn to use the Wizard which is by far the easiest and quickest method as it guides 
you through each step of the merge process so you always know what you need to do at each point.
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10.4 MAIL MERGE WIZARD:
Mail Merge Wizard in MS Word is a powerful tool for creating personalized documents, such as letters, emails, 
envelopes, labels, or directories. Here is a step-by-step guide to using the Mail Merge Wizard.

10.4.1 Starting the Mail Merge Wizard- Step-by-Step Procedure:
1.	 Open MS Word
2.	 Go to the “Mailings” tab on the Ribbon.
3.	 Click “Start Mail Merge”.
4.	  Select “Step-by-Step Mail Merge Wizard”. This opens the Mail Merge task pane on the right side of the 

screen.
Step 1: Select document type that you want to create using Mail Merge

1.	 In the Mail Merge Task Pane, choose the type of document you want to create:
a.	 Letters
b.	 Email Messages			   c. Envelopes		
d. Labels				    e. Directory

2.	 Click “Next: Starting document” at the bottom of the pane.
Step 2: Select Starting Document

1.	 Choose how you want to set up your document:  
a.	 Use the current document:

Starts from the document currently open.
b.	 Start from a template:

Choose a pre-designed template.
c.	 Start from an existing document:

Open an existing document to use as your base.
2.	 Click “Next: Select Recipients”

Step 3:  Select recipients 

A. New recipient list
1.	 Choose your recipient list:

a.	 Use an existing list: Browse to an Excel spreadsheet, Access database, or  
	other data source.

b.	 Select from Outlook Contacts: Use your Outlook address book.
c.	 Type a new list: Create a new list from scratch.

2.	 If using an existing list or Outlook contacts, select the appropriate file or  
	contacts folder.
3.	 Optionally, refine the recipient list by filtering and sorting.

4.	 Click “Next: Write your letter”.
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B. Existing recipient list

Create an address list in an existing file, such as an Excel workbook, or you can type a new 
address list from within the Mail Merge Wizard. Word can automatically place each address 
into the document.

1.	 From the Mail Merge task pane, select Use an existing list, then click Browse.

2.	 Locate your file(c:\My documents\LETTERS\ADDRESS LIST.XLSX) in the dialog 
box and click Open. 

3.	 The address list is in an Excel workbook, select the worksheet from the folder My 
documents\Letters\ADDRESS LIST.XLSX,then click OK.

4.	 In the Mail Merge Recipients dialog box, check each recipient used in the merge and 
or uncheck the remaining. click OK to close the dialog box.
Step 4: Write Your Letter:  

1.	Write the main content of your document.
2.	Insert merge fields where personalizes information should appear:
a.	 Click “Insert Merge Field” in the task pane or the “Mailings” tab.
b.	Select the field you want to insert (e.g., First Name, Email…).
c.	 Click “Next: Preview your letters”.

Step 5: Preview your Letters:   

1.	 Preview how your document will look for each recipient.

Use the arrow buttons to navigate through the recipients. (1 in 
the picture)
Make changes if necessary.

2.	 Click “Next: Complete the merge”(2 in the picture)
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Step 6: Complete the Merge

1.	 Choose how you want to complete the merge.
a.	 Print: Print the documents.
b.	 Edit individual letters: Create a new document with all the merged letters for final 

adjustments.
c.	 Send Email Messages: If you’re creating email messages, specify the subject line and 

other email options.
2.	 Follow the the prompts to finish the merge.

Word merges the main document and the information from the data source into a new 
Word document, or merges it and sends it to the printer, based on the option you chose.

Print Documents: Merges records and sends them directly to the printer.

1.	 Select the option you want to use to finish the mail merge.(1 in the picture below)

You can also click the Finish & Merge button on the ribbon and select a merge option there.

You’re also given the option to choose the records to merge. You can merge all the records in the 
list, only the currently displayed record, or specify a range.

2.	 Select the records you want to merge. (2 in the picture below)

Click OK. (3 in the picture below)

Complete the Merge!
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 BR AIN DEVELOPER 

I) CHOSE THE BEST ANSWER
1. What is the primary purpose of using the Mail Merge Wizard in Microsoft Word?

   A) To create and print documents with complex formatting
   B) To create personalized documents for multiple recipients
   C) To edit images within a document
   D) To convert documents to PDF format

2. In which tab can you find the Mail Merge options in Microsoft Word?

   A) Home
   B) Insert
   C) Mailings
   D) Review

3. Which of the following is NOT a document type option in the Mail Merge Wizard?

   A) Letters
   B) Envelopes
   C) Reports
   D) Labels

4. What is the first step in the Mail Merge Wizard?

   A) Write your letter
   B) Select recipients
   C) Preview your letters
   D) Select document type

5. When selecting recipients, which of the following options is NOT available?

   A) Use an existing list
   B) Select from Outlook contacts
   C) Type a new list
   D) Import from PDF

6. Which file format is commonly used as a data source for Mail Merge in Microsoft Word?

   A) .txt
   B) .xls/.xlsx
   C) .jpg
   D) .pdf

7. In the “Write your letter” step, which feature allows you to insert personalized information?

   A) Insert Page Break
   B) Insert Merge Field
   C) Insert Table
   D) Insert Hyperlink
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8. What can you do in the “Preview your letters” step of the Mail Merge Wizard?

   A) Change the document type
   B) Write the main content of the letter
   C) Navigate through and view how each recipient’s letter will look
   D) Select the recipient list

9. Which option is NOT available in the final step of the Mail Merge Wizard?

   A) Print the documents
   B) Save the document as a template
   C) Edit individual letters
   D) Send Email Messages

10. What happens when you select “Edit individual letters” in the final step of the Mail Merge Wizard?

    A) The merge fields are removed from the document.
    B) A new document is created with each letter on a separate page.
    C) The document is saved automatically.
    D) The document is converted to a PDF file.

11. Which of the following is not essential component to perform a mail merge operation?

   A) Main document 
   B) Data source 
   C) Merge fields 
   D) Word fields



Scratch 2.0



In recent years, interest in coding has exploded. All over the world, people want to learn coding skills that is now 
considered vital in the workplace and in homes too. Everyone wants to learn how to code for the fun of it.

In the past, programmers had to type out lines of code by hand, using obscure commands and mathematical symbols. 
A single period out of place could ruin everything. Today, you can build amazingly powerful programs in minutes by 
using drag-and-drop coding languages like Scratch, which is used in this book.

As learning code has become easier, more people have discovered the creative potential of computers. Scratch is 
all about using code for creative purposes – to make art, music, animation and special effects. With a little bit of 
imagination you can produce dazzling results, from glittering fireworks displays to kaleidoscope-like masterpieces that 
swirl and beat in time to music. 

Computers are used everywhere in all sorts of creative ways – So take control of your computer and learn how to 
program it. Programming puts a world of possibilities at your fingertips.

THINK LIKE A COMPUTER

Programming, or coding simply means telling a computer what to do. To write a program you need to think like a 
computer, which means breaking down a task into a series of simple steps. Here’s how it works. 

A SIMPLE RECIPE

Imagine you want a friend to bake a cake, but your friend has no idea how to cook. You can’t simply give an instruction 
like “make a cake” – your friend won’t know where to start. Instead, you need to write a recipe with simple steps like 
”break an egg”, “add the sugar” and so on. Programming a computer is a bit like writing a recipe.

COMPUTER LANGUAGE

Although you can understand the recipe of a cake, a computer can’t. 
You need to translate the instructions into a special language that the 
computer can understand – a programming language.

PROGRAMMING LANGUAGES

To tell a computer what to do, you need to speak the right kind of language: a programming language. There are lots 
to choose from, ranging from easy ones for beginners, like Scratch, to complex languages like C, C++, Python… that 
take years to master. A set of instructions written in any programming language is called a PROGRAM.

POPULAR LANGUAGES

There are more than 500 different programming languages. The most popular languages use English words, but lines 
of code look very different from English sentences. Here’s how to get a computer to say “ Hello” on screen in just a 
few of today’s languages.

C 

The C programming language is often used for code that runs directly on a computer’s hardware, 
such as Windows operating system. 

C++

This complicated language is used large, commercial programs such as word processors, 
web browsers

		  CODE:
Computer instructions written in 
a programming language are often 
called code. Coding is programming.

#include<stdio.h>
main()
{
printf(“Hello”);
}

#include<iostream.h>
Int main()
{
std.cout<<“Hello”<<std.endl;
}



Scratch

Beginners often start with simple programming languages such as Scratch. Instead of 
typing out code, you build scripts with ready-made blocks of code

Python

Python is a very popular, all-purpose language. The lines of code are shorter and simpler than 
in other languages, making it easier to learn. Python is a great language to learn after Scratch.

THE PROGRAMMING LANGUAGE USED IN THIS BOOK IS CALLED SCRATCH.

In this book you’ll get to make lots of great projects that will make you think and code creatively. This book shows you 
how to build some really cool projects using Scratch programming language. Programs are made by dragging together 
ready-made blocks of instruction code to control colorful characters called sprites. 

print(“Hello”)
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GET TING STARTED 
WIT H S CRATCH 2.0

ESSENTIAL LEARNING OBJECTIVES:
11.1 Introduction to Scratch 2.0

11.2 Setting Up Scratch 2.0 Offiine Editor

11.3 Scratch Interface Elements

11.4 Direction and Degrees

11.5 Working with Code Blocks

11.6 Creating a New Project

11.1 INTRODUCTION

Scratch is an event-driven, block-based visual programming language. In Scratch, we can create our own interactive 
stories, games, and animations using building blocks. Scratch is a very user-friendly language, and it’s one of the 
reasons why it’s so popular with young coders. It is a very useful tool for young creators to learn and implement 
coding logic
Scratch was created by the Lifelong Kindergarten group at MIT Media lab and is available for free download at 
http://scratch.mit.edu. It can also be downloaded to use offline Or can be used online on its website. 
In this book, we will discuss the basics of Scratch 2.0 Offline version for Windows. Once Scratch 2.0 offline version 
is downloaded and installed on a computer, you do not need Internet access to use it. 

11.2 SETTING UP SCRATCH 2.0 OFFLINE EDITOR:
Step 1: Visit the Scratch Official Website - https://scratch.mit.edu/download/scratch2
As soon as you click on the link given here, you will be directed to a page where - Chances are your operating 
system Windows or mac-OS will be auto-selected, but just 
in case it is not, choose your OS by clicking on the relevant 
icon. 
Step 2: Click on Scratch 2.0 Offline Editor, and it will 
take you to the page which has 3 components: 

1.	 Adobe AIR: This is a pre-requisite to downloading 
Scratch Offline Editor

2.	 Scratch Offline Editor: You can download Scratch 
2.0 for Mac OS X, Mac OC 10.5 & Older, and Windows

3.	 Support Material: You can also download Starter Projects, Getting Started Guide and Scratch Cards
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The download page includes an online installer that will 
allow to install the prerequisite software, namely Adobe 
Air, on your computer. The screenshot above also shows 
the Scratch 2 Offline Editor:
Step 3: Download and install Adobe Air as a prerequisite 
for using Scratch 2.0 offline.

Step 4: Next download Scratch 2.0 to your system and 
run the application. The installation will take 3–4 minutes, depending on your system’s speed. After the installation 
is complete you can create projects and then share them to the Scratch website.

GETTING STARTED WITH SCRATCH

1.	 Click Start button

2.	 Choose All Programs

3.	 Click Scratch 2.0

11.3 SCRATCH INTERFACE ELEMENTS
Scratch provides you with a powerful interface to create programs such as games or animated stories. The 
scratch team at MIT designed the interface to be easy to use.

Four Main Elements of Scratch: 
1)	 Sprites 

2)	 Blocks Palette

3)	 Script 

4)	 Stage

You can open Scratch 2.0 using any 
other method suitable for you
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1) SPRITE

Sprite(s) is/are the actors or main characters of the project. The cat sprite is the default sprite but you can delete it or 
add more sprites. The Sprites appear on the Stage, and their code blocks control their behaviour. You can program 
a sprite by adding code blocks to the Script/Code Area on the right side of the screen. Sprites must be programmed 
to carry out every function you want them to perform. 

2) BLOCKS PALETTE The block palette is where the different code blocks are located. The different type 
of script blocks include: motion, control, looks, sensing, sound, operators, pen, variables. The script area 
is where you will drag your code blocks. The code blocks snap together to define the actions of your sprite.

3) SCRIPT   

Code blocks are elements used to program the sprite to do or say something. In Scratch, a stack of code blocks is 
called a script. Each sprite has its own scripts. When you click the sprite in the Sprite List, that sprite’s scripts will 
display in the Script/Code Area.  Click the Scripts tab to  display the Script/Code Area. The Script/Code Area is 
replaced by the Paint Editor and Sound Editor when the Costumes and Sounds tabs are selected, respectively. 

4) THE S TAGE  is the background of the project. It is the main area where all the action of your program takes 
place. The stage is 480 pixels wide and 360 pixels tall. The stage has scripts, backdrops and sounds associated with 
it. The different backdrops can be made to change as the story plays out.

You should also pay attention to the green flag and red stop sign in the upper right corner of the stage window. 
These buttons can be configured to control the beginning and end of your program.

You will also find the stage toolbar above the stage window.

The stage toolbar functions, from left to right, are:
stamp - create a copy of an existing sprite/block.
scissors - delete a sprite /block.
grow sprite - increase the size of a sprite.
shrink sprite - decrease the size of a sprite.

All sprites have a particular position on the stage. Sprites cannot move behind the stage — the stage is al-
ways at the back layer. Scratch determines where to display sprites through 
the coordinate system. It uses the Cartesian coordinate system in which on 
a two-dimensional plane, a point has two values to locate  its exact position.

Scratch’s coordinate system uses 2 coordinates: X position and Y position, 
to determine the location of a sprite on the stage. The X position value 
determines the horizontal location of the sprite and the Y position value 
determines the vertical location or height. The screen is a 480 x 360 
rectangle with the origin in the centre, such that the X position can range 
from 240 to -240, where 240 is the rightmost a sprite can be and -240 is 
the leftmost, and the Y position can range from 180 to -180, where 180 is 
the topmost it can be and -180 is the lowest it can be.
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11.4 DIRECTION AND DEGREES:
Words like up or right are perfectly understood as directions by humans 
like you and me. But the computer needs a number to indicate an exact 
direction. All sprites in Scratch have their own direction number. The 
direction numbers are between −180 and 180 degrees. Pointing at 0 degrees 
is facing up. Pointing at 90 degrees is facing to the right. The following figure 
shows several directions and their degrees. Notice that the degrees increase in 
the clockwise direction and decrease in the counter clockwise direction. Also, 
notice that −180 and 180 degrees point in the same direction: down.

 In Scratch, you can set the rotation style of a sprite to control how it 
rotates when it moves. There are three rotation styles you can choose from:

There are three rotation styles: 

a. The all-around  rotation style - The sprite can rotate freely in any direction

b. The left-right rotation style can rotate the sprite horizontally only.

c.  don’t rotate – The sprite remains fixed and does not rotate.

To set the rotation style of the sprite in Scratch, you can use the Set Rotation Style block found in the Motion 
category. Here’s how you can do it:

1.	 Drag the Set Rotation Style block into your script area.

2.	 Select the desired rotation style from the drop-down menu in the block.

For example, if you want your sprite to only face left or right, you would set the rotation style to “left-right.”
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EXAMPLE CODE:

The pick random -180 to 180 block chooses a random number to 
use as the direction. Then, the point in direction block points the 
sprite in that direction. This means that the sprite could be pointed in 
any possible direction.

11.5 WORKING WITH CODE BLOCKS:
Before you begin programming, it’s good to get an idea of how the code blocks snap together in the editor. 
Throughout this book, you’ll learn what each code block does.

a.	 ADDING BLOCKS

To create a new code block, drag it from the center Block Palette to the Code 
Area. The code blocks that have a notch on top and bump on the bottom are 
called stack blocks. To snap a stack block together with another stack block, 
drag the block close to the bottom of the other. When a white line appears, 
drop the block to connect it to the stack. 

You can change a white field inside a block by clicking the white area and entering new input.

The rounded blocks are called reporter blocks. They fit inside the white fields. For example, in the following figure, 
the green pick random 1 to 10 block fits inside the white field. When the left edge of the reporter block is over 
the white field, a white outline appears around the white field. If the left edge isn’t over the white field, the white 
outline won’t appear, and the reporter block cannot be placed inside.

b.	 DELETING BLOCKS

To remove blocks, drag them out of the script. If you remove a stack block, you’ll also remove the stack blocks 
connected beneath it, as shown in the next figure. You may need to set aside these blocks if you want to reconnect 
some of them to the script. Drag the blocks you want to delete over the Block Palette to remove them from the 
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Stage. You can always add more blocks from the Block Palette when you need them.

You can also right-click a block and select Delete from the menu that appears. 
If you accidentally delete some blocks, you may be able to restore them by 
selecting Edit ▶ Restore from the navigation bar.

c.	 RUNNING PROGRAMS

Create the following program by dragging blocks from the Block Palette to the Code Area:

This program will start when you click the green 
flag. Programs execution begins with the top 
block (When GREEN flag clicked) and then run 
the next code block in the script in a sequential 
manner.

 In this example, a speech bubble appears above 
the sprite and displays “Hello!” for 2 seconds. 
The sprite moves forward by 10 steps and turns 
counterclockwise by 15 degrees. All the blocks in 
the forever block will execute in a loop(again and 
again) forever and will stop only when you click 
the red stop sign. 

You can also run a script or block by clicking it - But clicking the green flag is the normal way to start your program.

You can have as many sprites and code blocks in your programs as you want. As you create the programming 
projects in this book, you’ll learn about Scratch’s many different types of code blocks.

11.6 CREATING A NEW PROJECT
To create a new Project follow these steps

1.	Click on file menu
2.	Click on new option

OTHER FILE MENU OPTIONS
·	 New Option: Creates a new project from a blank template.
·	 Save Option: Saves the current project.
·	 Open Option: Open a project already created
·	 Record Project video: The option will record the project video.
·	 Share to website: It allows you to share a project.
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Example 1: Create a Scratch program to draw a Square

1.	 Drag the ‘When  Clicked’ - hat block from Event 
blocks category 

2.	 Drag and stack the Clear block from Pen category to the hat block above.
3.	 Drag the Pen Down block from the pen category and connect to the blocks above,
4.	 Drag the Repeat block from Control block category and change the value in the white 

field to 4.
5.	 Insert the Move 10 steps block from motion block category into the Repeat 4 Block 

from step 4. Change the value in the white field from 10 to 50.
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 BR AIN DEVELOPER 

I) CHOSE THE BEST ANSWER

1.	 You access the code blocks from the Blocks Area  in the_______

a. Center		  b. Left			   c. Right		  d. up

2.	  Select the __________tab  to display the Scripts Area

a.  block		  b. Scripts		  c. project		  d. sound

3.	 Click the __________ sign will stop it.

a. red		  b.  blue			  c. green		  d. black

4.	 To avoid losing the content click

a. load now		 b. open now		  c. edit now		  d. Save 

5.	 Which of the following is not a block category?

a. Motion		  b. Looks		  c. Sound		  d. video

6.	 How many degrees are there in a circle?

a. 180		  b.90			   c.360			   d.240

7.	 Stage in scratch is a

a. Script		  b. Backdrop		  c. Block		  d. Sprite

8.	 Projects are made up of objects called

a. Food	  	 b. Sound		  c. Data			  d. Sprite

9.	  Sprites move and perform actions on the	

a. Block Palette	 b. Stage		  c. Script Area		  d. Script

10.	In Scratch 2.0, the picture on the stage is called a

a. Painting		  b. Backdrop		  c. Screen saver	 d. Costume

11.	The __________ coordinates of the stage lies on (0,0).

II) FILL IN THE BLANKS

1. 	 Sprites appear on the______________.

2. 	 Clicking the ___________ will start your program

3. 	 _______________is the background where all actions takes place.

4. 	 Scratch is a __________________programming language.

5. 	 _______________ are the objects that perform actions in a scratch project.
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III. ANSWER THE FOLLOWING QUESTIONS: 

1.	 Write the steps to start Scratch.

											         

											         

											         

2.	 Name the 3 tabs in scratch.

											         

											         

											         

3.	 Write the script to rotate the sprite by 40o

											         

											         

											         

4.	 What is difference between sprite and script?

											         

											         

											         

LAB ACTIVITY:
1.	 Create a script to make the cat draw a 

i.	 Triangle

ii.	 Square

iii.	 Rectangle

iv.	 Pentagon

v.	 Hexagon

Teacher’s Signature

An algorithm is a set of well-defined 
instructions or steps designed to 
solve a specific problem or perform a 
computation. 
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ESSENTIAL LEARNING OBJECTIVES:
 12.1  INTRODUCTION

 12.2  TYPES OF BLOCKS

12.1 INTRODUCTION:
Blocks in Scratch are the fundamental building elements used to create code. They are designed to fit together like 
puzzle pieces, making it easy to build scripts. The blocks connect to each other vertically like a jigsaw puzzle, where 
each block type (hat, stack, reporter, Boolean, or cap) has its own shape and its own slot shape for it to be inserted. 
Series of connected blocks are called scripts.

12.2-(A) TYPES OF BLOCKS - BASED ON THEIR SHAPE:
THE SIX DIFFERENT TYPES OF BLOCK SHAPES.

HAT BLOCKS: Hat blocks are designed to start a script. These blocks have a rounded top 
and a notch at the bottom of the shape. Other blocks can be placed below it but not on the 
top. In total there are 11 Hat blocks. 

STACK BLOCKS: This is the most common block shape. Stack blocks can fit inbetween 
blocks. These blocks perform the main commands. They have a notch at the top and a bump 
at the bottom and can also fit in between blocks. There are 77 stack blocks.

BOOLEAN BLOCKS: They represent the conditional logic that returns either true or false. 
These blocks are elongated hexagonal shaped with pointy ends. There are 13 of these blocks. 

REPORTER BLOCKS: These blocks can hold values, which can be numbers or strings or 
Boolean. Shape can be rectangle with rounded edges.  There are 37 of these blocks. 

C BLOCKS: These blocks are C shaped and are also known as Wrap blocks. 
These blocks check if a condition is true and then loop/branch the blocks within 
the C shape. There are 5 C blocks present in the Control category. 

CAP BLOCKS: these blocks end the script. They are shaped with a notch at the top and a flat 
bottom. Blocks cannot be placed below them. There are 2 Cap blocks, which are found in the 
Control category.  

Each block has a unique shape that reflects its function and how it connects with other blocks. This unique shape 
allows blocks to snap together only in ways that make logical sense – ensuring that the code flows logically. 
In total, there are 8 Hat Blocks, 5 C Blocks, 34 Reporter Blocks, 14 Boolean Blocks, 2 Cap Blocks and 
62 Stack Blocks, for a total of 125 BLOCKS.

WORKING WITH  
CODE BLOCKSCH
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12.2-(B) TYPES OF BLOCKS - BASED ON THE FUNCTION/COLOUR
There are a total of 9+1 built-in block categories available in Scratch 2.0. Each category is represented 
in a different colour. The blocks which fall under the same category have a common colour.  
For Example - Motion, Looks, Sound, Event, Control, Sensing, Pen, Operators, Data (Variables & List), 
and My Blocks. 

1. CONTROL BLOCKS: - ORANGE COLOURED

Control blocks are the foundation of your Scratch projects, allowing you to specify how 
and when actions occur. For example, you can use the “repeat” block to make a sprite walk 
back and forth again and again. Some of the control blocks are as follows:

A. Repeat Block: This block is used to repeat commands for a specified number of 
times. (you want to repeat the command for x times).

B. If then else Block: These blocks are a type of conditional block that is used to 
carry out a particular action. If the set condition is met, it will perform the action. 
Otherwise, it will perform the alternative action that is defined under the else block. 
For example

Using Control Block – Draw a line with pen after the user wait for 1 second. 

1.	 Click on the Control category of blocks and drag the block to the 
script area.

2.	 Drag the  block from pen category of blocks to the script area.

3.	 Drag the   block from motion category of blocks to the script area.

4.	 Snap the blocks together in this same order.

5.	 Click on the first block to execute the script.

The sprite will wait a second and then draw a line while it moves 50 steps.

2. MOTION BLOCKS: DARK BLUE COLOURED

These blocks in Scratch 
are used to move or 
turn sprites. They are 
used to control the 
sprite’s movement.  
Motion blocks enable 
the students to move 
their sprite(or character) 
around in the stage.
Using Motion Blocks Using Motion Blocks – Rotate sprite by 30 

1.	 Click the Motion Tab and Drag the block to the script area 
2.	 Click on 15 and change it to 30.

3.	 Next click this block to see the effect  on the stage.
The sprite rotates clockwise by 30 degrees whenever this block is clicked
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IF ON EDGE BOUNCE

If on Edge, bounce block is a motion category block. When a sprite is 
touching any edge of the stage, then the “IF ON EDGE, BOUNCE” 
block will turn the sprite away from the edge. It will look like a ball 
bouncing off a wall. 
For example, if the direction of sprite before bouncing is 90, then the 
direction of sprite after bouncing will be -90.

Other alternative code is↓

3. LOOKS BLOCKS: - PURPLE COLOURED

These code blocks are used for the 
purpose of controlling a sprite’s 
appearance. With the help of Looks 
block, you can modify the colour, 
graphics effect, and sprite size. For 
example, Say and Think blocks are 
useful in adding speech or thought 
bubbles to the sprite in a Scratch programming script.
Using Looks Block – Change the color of the sprite. 

1.	 Click the Looks blocks category and Drag the block to the script area.
2.	 Click this block to view the change in the sprite.

The sprite is twisted around from its center point every time the block is clicked.
4. PEN BLOCKS: - DARK GREEN COLOURED
Pens are a category of blocks we can use to draw on the stage. They are the blocks that control the pen. • There are 
11 Pen blocks in Scratch 2.0.  Pen blocks can be used to draw in different colors and  sizes.

Using Pen Block – Change the color of the pen. 
	 Procedure:

1.	 Click the Pen category blocks and Drag the  
blocks, to the script area.

2.	 Click the Motion blocks category and drag the block to script area.
3.	 Snap the three blocks together and Click the  blocks 

to view the sprite draw a Multi-coloured ine as it 
moves 10 steps at a time.

The sprite will draw a line in a different colour every time the stack of blocks is clicked.  
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5. OPERATOR BLOCKS: - LIGHT GREEN COLOURED
 Scratch offers 17 operator blocks, which 
enable mathematical functions, decision 
making and string handling.These 
operators include addition (+), subtraction 
(-), multiplication (*), division (/), 
comparison operators (<, =, >), Boolean 
operators (And, Or, Not), string operators (join, letter of, length of ), and other handy operators like modulus (%), 
round, absolute value, and square root. These operators help in performing calculations, making decisions, and 
manipulating data in Scratch.

Operator blocks are either Boolean or reporter kind of blocks.

6. DATA BLOCKS: - DARK ORANGE COLOURED

Variables and lists fall under this category. They allow you to store and manipulate 
information during your program’s execution. There are 5 variable blocks in Scratch 2.0.

Variables:

•	 Variables are like little containers where you can store different types of data (numbers, 
text, or even Boolean values).

•	 Let’s say you have a sprite named “Hero.” You can create a variable called “Score” to keep 
track of how many points Hero collects on the journey. Variables are your secret power-ups, making your 
projects dynamic and exciting.

7. SOUND BLOCKS: - PINK COLOURED 

The sound blocks enable you to control sounds in the Scratch project. The blocks are used 
for adding and controlling the sounds of sprites or backdrops. Each sprite and backdrop 
comes with its own default sound, These blocks allow you to add various sound effects and 
music to your Scratch projects, enhancing the overall experience
Using Sound Block – Play the sound of the cat ‘Meow’ by the sprite. 

Procedure:

1.	 Click on the Sound category of blocks

2.	 Drag the block to the script area.

3.	 Click the block and you will hear the cat say Meow sound.

The sprite will tell Meow every time it is clicked on.

8. SENSING BLOCKS:  LIGHT BLUE COLOURED
The Sensing blocks  are used to get user input, detect conditions, and report on values in your project. Sensing 
blocks is like giving your code super senses. They allow your sprite to react to its surroundings. For example, you 
can make your sprite say, “Ouch!” when it touches an obstacle. Sensing blocks give your code the ability to respond 
to the world around it.
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Ask() is a sensing category block and a stack block. It 
is the INPUT block used in Scratch. 

It is a block that asks a question and then waits for the 
input from the 
user. An input 
box appears on 

the stage where the user can type the answer. The answer is stored by default in 
the answer block. The answer block with the answer can be used in another 
scratch block where it is needed.  

Example: 

1.	 Click and drag the Ask block from Sensing 
category blocks to the Script Area.

2.	 Insert the Answer block (– a reporter block 
- also from Sensing category) into the World 
text box of a JOIN operator. Next insert this JOIN operator into the Hello textbox of another JOIN 
operator. Change the text “World” to “Welcome to Scratch!!”. 

Every time this stack is clicked you need to type your name in the input box and Press enter key.

The sprite will say Hello Rekha Welcome to Scratch!! (where Rekha is the input value stored in the answer 
block)

9. EVENT BLOCKS: - YELLOW COLOURED

The yellow  coloured event blocks are fundamental to Scratch. Event blocks are used to define when and 
how a script has to be run. These blocks set a triggering moment ( For example, Clicking the green flag) that 
enables the program to execute. Event blocks are mostly Hat blocks that are used to begin a  script execution. 
Other blocks in a script can only be placed below the Hat blocks. For example, 

Using Event Block Moving sprite by 10 steps when (flag) clicked. 

Procedure:

1.	 Click on the events category of blocks and drag the  block to the script area

2.	 Drag the block from motion category and snap it into the When Green Flag Clicked 
block..

3.	 Click the green flag    icon to see the effect. 

The sprite moves by 10 steps whenever the     flag is clicked 
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BR OADCAST BLOCKS

Broadcast is a message sent through the Scratch programming editor to all sprites in the project 
for activating the scripts with the matching Hat Blocks. Broadcast is an “EVENTS” category  
block. They are useful in creating games and animation projects as they trigger specific scripts.

The 3 broadcast blocks in Scratch are:

“broadcast ()” block     

This broadcast block is a Stack block used to send a broadcast message to the complete project. 
This block sends the broadcast messages without any wait in the scripts.

“broadcast () and wait” block    

This broadcast block is a Stack block used to send a broadcast message to the complete project. This block is very 
similar to the “broadcast ()” block, however, the only difference is that this block sends the broadcast messages 
and waits until all script gets activated and then stop running.

“when I receive ()” block  	 	

This broadcast block is a Hat block used to activate its scripts when a specific broadcast message is received.

Broadcast messages are sent using the “broadcast ()” and “broadcast () and wait” blocks and those messages are 
received using the “when I receive ()” block.

How to broadcast a message in Scratch?

Every time the sprite is clicked, the broadcast message “Fly” is sent to the project and the hat block “When 
I Receive [Fly]” will activate its scripts.
10. MY BLOCKS: PURPLE COLOURED
My Blocks are purple-coloured blocks that specifically hold the procedure for selected sprites. They are the 
combination of more than one block that can be grouped together to form a single block These blocks are also 
known as user-created blocks. It enables the user to build new blocks for a sprite.

WORKING WITH DIFFERENT BLOCK CATEGORIES:
The block palette is where the different code blocks are located. The different type of code blocks include: 
Motion, Looks, Sound, Event, Control, Sensing, Pen, Operators, Data (Variables & List), and My Blocks. 
The script area is where you will drag your code blocks. The code blocks snap together and define the actions of 
your sprite.

SAMPLE CODE using different block categories Draw a circle using the pen in scratch. 

1.	 Click event category of blocks and drag the block to the script area.

2.	 Click the pen category of blocks and drag the clear and the pen down blocks. 
Snap them together as shown.
3.	 Go to  control category of blocks and drag the  block to the script area.
4.	 Change the value in repeat block to 360 degrees.
5.	 Click the motion category blocks and drag the blocks move (1) steps and turn (1) 
degrees. 
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6.	 Insert the blocks of step 5 into the repeat 360 block.
7.	 Snap the blocks of step 1 with step 2 and then step 6 together.
Clicking the green flag will make the sprite draw a circle.

 BR AIN DEVELOPER 

I) MATCH THE FOLLOWING
	 1. 	 MOTION BLOCK 	 – 	 ADDS SOUND

	 2. 	 LOOKS BLOCK 	 – 	 INTERACTIVE GAMES

	 3.	 SOUND BLOCK 	 – 	 MANIPULATE DATA

	 4. 	 PEN BLOCK 	 – 	 TO MOVE SPRITE

	 5. 	 DATA BLOCK 	 – 	 PURPLE COLOUR

II) FILL IN THE BLANKS

1.	 The yellow _________ blocks are fundamental to Scratch.

2.	 ____________ can also fit in between blocks.

3.	 The code blocks that have a notch on top and bump on the bottom are called ___________

4.	 When a __________ outline appears, drop the block to connect it to the stack.

5.	 The program stops only when you click the________ stop sign.

6.	 You can  add code blocks to the ________________.

7.	 A stack of code blocks is called a ________________.

8.	 Blocks in a script are executed in a ______________ manner.

9.	 The forever block execution can be stopped by clicking _________________.
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SAMPLE CODE:
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LAB ACTIVITY: WRITE SCRIPT TO DRAW

REVIEW EXERCISE:

CHOOSE THE CORRECT OPTION:

1. What does the “If” block do in Scratch?

A. Repeats the enclosed code a specified number of times.

B. Executes the code inside if only when a specified condition is true.

C. Continues to run code indefinitely until stopped.

D. Loops the enclosed code until a specified condition becomes true.

2. Which block in Scratch allows you to execute one set of code if a condition is true and another set if it 
is false?

A. Repeat ()

B. Forever ()

C. If Else ()

D. Repeat Until ()

3. How does the “Repeat” block do in Scratch?

A. Executes the enclosed code indefinitely.

B. Repeats the enclosed code a fixed number of times.

C. Repeats the enclosed code until a condition is true.

D. Executes the enclosed code if a condition is true.

4. What is the primary difference between the “Repeat” and “Repeat Until” blocks?

A. “Repeat” executes indefinitely, while “Repeat Until” executes a fixed number of times.

B. “Repeat Until” executes until a condition is true, while “Repeat” executes a fixed number of times.

C. “Repeat” executes based on a condition, while “Repeat Until” does not.

D. “Repeat Until” executes indefinitely, while “Repeat” executes based on a condition.

5. What will happen in Scratch if you use the “Forever” block?

A. The enclosed code will run a specified number of times.

B. The enclosed code will run until a condition becomes true.

C. The enclosed code will run indefinitely until the program is stopped.

D. The enclosed code will run based on a specific condition.



68

6. In the context of Scratch, what is the purpose of using a flowchart?

A. To execute code repeatedly.

B. To visually represent the logic and flow of a program.

C. To run code based on conditions.

D. To store and compare variable values.

7. Which block would you use to make a sprite move until it touches the edge of the stage?

A. If ()

B. Forever ()

C. Repeat Until ()

D. Repeat ()

8. How does the “If Else” block enhance decision-making in Scratch programming?

A. It allows for repeated execution of code.

B. It executes the code in the “If ” section if the condition is true, otherwise executes the code in the “Else” 
section.

C. It continuously runs code until stopped.

D. It stores and manages variable values.

Teacher’s Signature
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CONT ROL BLOCKS

ESSENTIAL LEARNING OBJECTIVES:
13.1 CONTROL FLOW

13.2 CONTROL FLOW BLOCKS IN SCRATCH

13.3 RECAP

13.4 CODING EXAMPLES

13.1 CONTROL FLOW?
The term control flow refers to the order in which the instructions 
in your program are executed. Consider this Scratch program:

What this program does is: when the space key is pressed, all 
of the blocks beneath it are executed. Now, each block in this 
program tells the computer to do something, right? So let’s think 
of each individual block as an instruction. 
If you run the program, you’ll see that the instructions are executed 
in a top-down structure: in other words, 
it starts at the top and works its way down 
through the instructions until it reaches 
the bottom. You could say that its control 
flow is sequential or linear. you’ll see that 
the program —

•	 Makes Scratch Cat say “Hello” for 2 seconds

•	 Rotates Scratch Cat clockwise by 180 degrees

•	 Waits for 1 second

•	 Makes Scratch Cat think “Hmm…” for 2 seconds

•	 Resets Scratch Cat’s orientation, so that he’s facing the right

You could say that the control flow of the program we discussed earlier looks a little something like this: figure on 
the right

But a program’s control flow is not always so straightforward. In fact, it’s very common to have instructions in 
your code that are repeated, or branching paths in the control flow of your program. There’s an entire category of 
statements that ALTER this control flow of your program: they’re called control flow statements.
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13.2 CONTROL FLOW BLOCKS IN SCRATCH
Control coding blocks are orange blocks that control the flow of your program allowing you to specify 
how and when actions occur. These blocks are essential for introducing logic and interactivity into 
your projects.
The types of control flow statements available  in Scratch are

1)	 LOOPS

2)	 DECISION-MAKING STATEMENTS. 

3)	 EVENT HANDLING

4)	 BROADCASTING AND RECIEVING

You can find these statements in the Control category.

1)	 LOOPS

Loops are a really fundamental concept in programming. A loop will continue to repeat executing blocks again and 
again  until a certain condition is met (i.e. until a condition is true). There are three loop blocks that you’ll find in 
Scratch:

 

 a. THE REPEAT X LOOP

The Repeat X loop repeats the instructions contained within it for a 
specified number of X times. So, if you had a program like this:

The Scratch Cat would turn 15 degrees clockwise for a total of ten 
times. The instructions within the repeat block are executed 
repeatedly for 10 times. Its control flow looks a little something 
like this:

EXAMPLE: Using Repeat X Loop to animate the sprite with 
Costumes:

Imagine you’re creating an animation where a sprite changes costumes. Instead of using 
separate code for each costume change, use the “Repeat” block:

repeat (100) 
Move 10 steps    
next costume
if on edge bounce
set rotation style to left-right    

end
This makes your animation smoother and easier to manage

 b.  THE FOREVER LOOP

The Forever loop repeats the instructions contained within it forever. Notice that there is no 
bump at the bottom, meaning blocks cannot get stacked below it. 

 So if you had a program like this:
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Then Scratch Cat would turn 15 degrees clockwise and will keep the code looping 
until you hit that stop sign! It’s like Repeat again and 
again…, except this never ends.

They don’t matter so much in Scratch, because you 
can always manually stop a program by clicking the 

red stop button. If you’re playing with forever loops, be sure to make good use of 
the Stop X block, which pairs rather nicely with the forever loop:

  c. THE REPEAT UNTIL X LOOP
The Repeat Until X loop repeats the instructions contained within it until the

 specified condition is met. You can create the condition using the Boolean blocks. 

2. DECISION-MAKING STATEMENTS

There are two decision-making statements that you can find in Scratch: if-then, and if-then-else.

a.	 THE IF-THEN BLOCK

The if-then block executes the instructions contained within it if the specified condition is 
met. So, consider a program like this:

What this program does is it checks if the left mouse button is pressed(true or false)? If 
pressed(if true-the condition for the execution of the if-then block will have been met) 
the cat will say “Hello!” If left mouse button is not pressed(if false- then the condition 
for the execution of the if-then block will not be met) the code inside the If block will 
be skipped. 

b.	 THE IF-THEN-ELSE BLOCK

The if-then block executes the instructions contained in the top section if the specified 
condition is met. If the specified condition is not met, then the instructions contained in the 
bottom section will be executed instead.
Here’s an example of the if-then-else block in an 

action, building on the example from above:

Just like in the if-then block example, the 
program checks if the left mouse button is 
pressed(true or false)? If pressed (the condition 
for the execution of the if-then block will have 
been met) the cat will say “Hello!” If left mouse 

button is not pressed (the condition for the execution of the if-then block 
will not be met) the cat will say “Goodbye!”
 3. EVENT HANDLING: 

•	 When Green Flag Clicked: Starts the script when the green flag is clicked.

•	 When [Key] Pressed: Starts the script when a specific key is pressed.
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•	 When Sprite Clicked: Starts the script when the sprite is clicked.

Event blocks control the moment When scripts start executing in response to specific events. It’s like giving your 
script the “start” signal. Examples include “When Green Flag Clicked”, “When [Key] Pressed”, and “When 
Sprite Clicked”. These blocks manage the initiation of scripts based on user interactions or predefined events, 
ensuring actions occur at the right moments.

4. BROADCASTING AND RECEIVING:

•	 Broadcast: Sends a message to all sprites.

•	 When I Receive: Executes a block of code when a specific broadcast message is received.

Broadcasting and Receiving: If you have multiple sprites, they can communicate with each other using broadcast 
messages. “Broadcast” blocks send messages, while “When I Receive” blocks listen for and respond to these 
messages. This coordination between different parts of your project allows sprites to synchronize their actions or 
trigger events across the entire project.

All of these control blocks enable you to create dynamic and interactive projects in Scratch.

13.3 RECAP
Control flow is the term used to refer to the order in which the instructions in a program are executed. The control 
flow of a simple program might be linear or sequential, but through the use of control flow statements, you can 
alter your program’s control flow.

Some examples of control flow statements in Scratch are loops — which cause instructions to repeat until a certain 
condition is met — and decision-making statements, which can create branching paths in your code, Event 
handling – which controls when and how a script should start execution, Broadcast and Receiving – which 
controls script execution based on broadcast messages.

4.3 CODING EXAMPLES:
1.	 Wait, repeat and Forever blocks with examples 

Here in the code shown, the sprite (cat) says hello after a gap of 3 seconds after the flag 
is clicked. For Ex. →

2.	 Repeat block in Scratch:- The code blocks kept inside the 
repeat block are executed by the computer the number of times specified in the repeat block. 
When the flag is clicked, the sprite (cat) will turn by 15 degrees for 10 times. 

3.	 Forever block in Scratch: - The code blocks kept inside the Forever block are 
executed by the computer forever until the program is stopped.

When the flag is clicked , the sprite (cat) will turn by 15 degrees forever.  

4.	 If  block comes with a condition. For example: in the code below, the condition is touching the edge of the 
screen. If the condition is true, the computer executes the code written inside the if block. Whenever the 
cymbal touches the edge of the screen, the cymbal will change the color as shown in the output.
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5.	 In the IF ELSE BLOCK , there is a section added to the code above which is else part. Whenever the con-
dition attached to the if is false , the computer goes to the else part and executes the code written inside the 
else part. For Ex: – In the code below , the cymbal changes the color whenever it touches the edge of the 
screen. If the cymbal is not touching the edge of the screen, the cymbal will show the original colour.

The Repeat Until () block is a Control block and a C block. This 
looping block is used to execute a block of code repeatedly as long as a 
specified condition is true. Once the condition becomes false, the loop 
terminates, and the execution continues to the next block after the loop. 
They help in automating repetitive tasks.

 BR AIN DEVELOPER 

CHOOSE THE CORRECT ANSWER
1. How many times will the code inside a Repeat (10) block execute?

A. Indefinitely

B. Until a condition is met

C. 10 times

D. Once

2. What is the purpose of the Forever block in Scratch?

A. Repeats code a specified number of times

B. Executes code indefinitely until stopped

C. Pauses code execution

D. Executes code only if a condition is true

3. When using an If block in Scratch, what happens if the condition is false?

A. The code inside the If block will execute

B. The code inside the Else block will execute

C. The script will stop executing

D. The condition will be re-evaluated
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4. How does the Repeat Until block differ from the Repeat block?

A. Repeat Until executes indefinitely, while Repeat executes a fixed number of times.

B. Repeat executes indefinitely, while Repeat Until executes a fixed number of times.

C. Repeat Until executes until a condition is true, while Repeat executes a fixed number of times.

D. Repeat Until and Repeat are identical in functionality.

5. What does the When Green Flag Clicked block do?

A. Starts the script when a specific key is pressed

B. Starts the script when the sprite is clicked

C. Starts the script when the green flag is clicked

D. Sends a message to all sprites

6. What happens when you use the Broadcast block in Scratch?

A. Executes a block of code until a condition is true

B. Sends a message to all sprites

C. Pauses code execution for a specified number of seconds

D. Changes the sprite’s costume

7. What is the primary purpose of the If Else block in Scratch?

A. To execute code indefinitely

B. To execute different blocks of code based on whether a condition is true or false

C. To pause code execution

D. To repeat a block of code a specified number of times

DO IT YOURSELF

Create a scratch project about your hobbies using the commands you have learned.

Teacher’s Signature
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ESSENTIAL LEARNING OBJECTIVES:
14.1  ADDING SPRITES / COSTUMES 
14.2  ADDING BACKDROP 
14.3  MANIPULATING SPRITES

14.1 ADDING SPRITES / COSTUMES / BACKDROP:
In scratch adding a sprite, a costume or a background is a key part of creating a project. Every new project starts 
with one sprite (the cat) already loaded, but you can also add as many of your own as you want, or you can edit or 
delete the cat.

•	 To add a Sprite – Click any one of the 4 options at the bottom right of 
the stage

•	 To add a Costume - Go to Costume tab above the Script area and Click any one of the 4 
options

•	 To add a Background – Click the stage thumbnail at the bottom left of the stage and 
Click any one of the 4 options

The four ways to create a new sprite/costume or backdrop are

•	 Select an image from Scratch’s default sprites/costumes and backdrops library

•	 The Scratch Paint Editor is Scratch’s built-in image editor. Draw your own sprite/costume or background 
in the paint editor, Many Scratch users create their own sprites, costumes, and backgrounds using it.

•	 Import from a local file on your computer (ex. import a downloaded or externally drawn image)

•	 Plug your digital camera into your computer with a USB drive and take a picture or use a webcam to take 
a picture

1. CREATING A SPRITE / COSTUMES FROM THE LIBRARY
Let’s start with the simplest way 

1.	 to add a sprite/costume is by importing one from the library.

2.	 Select sprite/costume from the library

3.	 Click OK

CREATI NG SPRI TES, 
CO ST UM ES, BAC KG RO U ND S 

& MA NI PU LATI NG SPRI TES
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2. PAINT A NEW SPRITE/COSTUME 
(USING THE TOOLS IN THE PAINT EDITOR)
1.	 Click the “Paint New Sprite/Costume tool in the New 

Sprite/Costume pane

2.	 This will open Paint editor

3.	 Using tools in the Paint Editor draw a new Sprite/Costume

3. CREATE SPRITE/ COSTUME BY 
UPLOADING A FILE
To upload a file as a sprite, hover over the sprite menu in the lower-right corner of the sprite area and choose 
“Upload.” Then, select the file you want to create a sprite from. Your image will appear on the costume tab when 
it has been uploaded.

4. CREATE SPRITE/COSTUME FROM CAMERA  
You can click a photo with a web camera icon to use it as your sprite. 	

1. Click on camera icon from sprite list. 

2. Click your desired photo, and save it to use it as a sprite / costume

14.2 ADDING BACKDROPS 

Follow the steps given in the picture.
1.	 Click the stage thumbnail at the bottom left corner 
of the stage.

2.	 Click the Backdrops tab

3.	 Select a background from the gallery or upload your 
own background.

SWITCH BETWEEN DIFFERENT  
BACKDROPS:

Follow the steps given in the picture.
1.	 Select the Backdrop thumbnail at the bottom 

left corner of the stage.

2.	 Click the scripts tab.

3.	 Click on Looks category

4.	 Click and drag the “Switch Backdrops to X” 
block to script area.

5.	 Select the scene from the dropdown.
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14.3 SPRITE MANIPULATION: In Scratch, sprite manipulation refers to changing and controlling the 
appearance, movement, and behavior of sprites (the characters or objects in your project). Sprites can be animated, 
moved around the screen, and interact with each other or the environment based on scripts you create. 

Key Aspects of Sprite Manipulation in Scratch:

1. MOVEMENT: Sprites can move around the stage using a variety of motion blocks. 

Move [10] steps: Moves the sprite forward by a specified number of steps.

Turn [15] degrees: Rotates the sprite by a certain number of degrees (clockwise 
or counterclockwise).

Go to x: [x] y: [y]: Instantly moves the sprite to a specific coordinate on the stage.

Glide [1] secs to x: [x] y: [y]: Moves the sprite smoothly to a specific coordinate 
over a given period of time. 

Point in direction [X]: Points the sprite in a specific direction 
(0 = up, 90 = right, -90 = left, 180 = down).

Change x by [X]: Changes the sprite’s horizontal position by a 
certain amount.

Change y by [X]: Changes the sprite’s vertical position by a certain amount.

2. COSTUMES: Sprites can have multiple costumes, which are different 
appearances for the same sprite. Costumes are useful for animating a sprite 
or changing its look during the program.

Switch costume to [costume]: Changes the sprite’s costume to a 
specified one.

Next costume: Switches to the next costume in the sprite’s costume 
list.

Change size by [10]: Increases or decreases the sprite’s size.

Set size to [100]%: Sets the sprite’s size to a specific percentage 
of its original size.

3. POSITIONING: Sprites can be placed and moved to specific locations on the stage. 

Show and Hide: Makes the sprite visible or invisible.

Go to [mouse-pointer]: Moves the sprite to a specific object or mouse pointer.

Set rotation style [left-right/all around/don’t rotate]: Controls how the sprite rotates (either left-right, 
freely around, or no rotation).

4. SENSING: Sprites can sense their surroundings and interact 
with other sprites or the environment.

Touching [object]?: Checks if the sprite is touching 
a specified object, such as another sprite or the stage’s 
edge. 
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Touching color [color]?: Checks if the sprite is touching a specific color.

Distance to [object]: Returns the distance from the sprite to another object, such as the mouse-pointer or 
another sprite.

5. LOOKS: The Looks blocks allow you to change the sprite’s appearance and add visual 
effects.

Say [Hello!] for [2] seconds: Makes the sprite display a speech bubble with text for a 
specified amount of time.

Change color effect by [25]: Applies a color effect to the sprite. 

Set [ghost] effect to [50]: Adjusts a sprite’s transparency.

6. INTERACTIVITY: Sprites can respond to user 
inputs, like mouse clicks or keyboard events.

When this sprite clicked: Starts a script 
when the sprite is clicked.

When [space] key pressed: Triggers an 
action when a specific key is pressed.

When I receive [message]: Executes code 
when the sprite receives a specific message 
from another sprite.

7. BROADCASTING AND COMMUNICATION: Sprites can communicate with each other using broadcast 
messages.	

Broadcast [message]: Sends a message to all sprites or scripts.

When I receive [message]: Reacts to a message broadcasted by another sprite.

EXAMPLE OF SPRITE MANIPULATION:

Suppose you want to make a sprite move to the right when the right arrow key is pressed:

When [right arrow] key pressed

Point in direction [90] 

Move 10 steps

In this example, the sprite moves 10 steps to the right and faces the right direction when the right arrow key is 
pressed.

TIPS FOR SPRITE MANIPULATION:

Costume animation: Switch between different costumes rapidly to create the illusion of animation  
(e.g., for walking or jumping).

Smooth movement: Use glide or continuous motion commands like “forever” loops to make sprites move 
more smoothly across the stage.

Interaction: Use sensing blocks to create interactive games where sprites can respond to each other or the 
user’s actions.

These tools allow you to fully control your sprites, making Scratch projects dynamic, interactive, and engaging.
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 BR AIN DEVELOPER 

I) MATCH THE FOLLOWING

A B
IMPORT

TAKING PHOTO

CREATE A NEW SPRITE

SPRITE LIBRARY

II) CHOOSE THE BEST ANSWER
1. How do you add a new sprite from the Scratch library?

A. Click on the “Paint New Sprite” button.

B. Upload a file as a sprite.

C. Click on the icon next to “New sprite” in the Sprites pane.

D. Use the web camera to take a photo.

2. What happens when you use the “Upload” option in the sprite menu?

A. It creates a new sprite from an existing file.

B. It paints a new sprite from scratch.

C. It takes a photo using your webcam.

D. It selects a sprite from the Scratch library.
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3. How can you create a new sprite using your webcam in Scratch?

A. Click on the “Paint New Sprite” button.

B. Use the “Upload” option from the sprite menu.

C. Click on the camera icon from the sprite list.

D. Select a sprite from the Scratch library.

4. What is the purpose of the “Paint New Sprite” option?

A. To upload a new sprite file.

B. To select a sprite from the library.

C. To create and paint a new sprite using the Paint Editor.

D. To add a backdrop to your project.

5. What coordinate system does the Scratch stage use?

A. X-Y coordinate system with (0,0) at the bottom-left.

B. X-Y coordinate system with (0,0) at the top-right.

C. X-Y coordinate system with (0,0) at the center.

D. Polar coordinate system.

6. How does the repeat (10) block work in Scratch?

A. It repeats the enclosed code until a condition is true.

B. It repeats the enclosed code indefinitely.

C. It executes the enclosed code for 10 times.

D. It pauses the script for a specified duration.

7. What does the glide () secs to x: () y: () block do?

A. Moves the sprite in a straight line to the specified coordinates.

B. Moves the sprite to the specified coordinates instantly.

C. Moves the sprite to the specified coordinates over a set duration.

D. Rotates the sprite to the specified angle.

8. How can you make a sprite change costumes in Scratch?

A. Use the repeat block to switch costumes.

B. Use the switch costume to () block.

C. Use the change costume by () block.

D. Use the set costume to () block.
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9. What does the if <touching color [red]?> then block do?

A. Changes the color of the sprite when it touches red.

B. Makes the sprite change its costume when it touches red.

C. Executes code inside the block if the sprite touches a red color.

D. Moves the sprite to a specific location if it touches red.

10. What kind of movement does the change X by (10) block create?

A. Rotates the sprite by 10 degrees.

B. Moves the sprite 10 steps to the right.

C. Moves the sprite 10 steps to the left.

D. Moves the sprite 10 steps up or down.

DO IT YOURSELF

Teacher’s Signature
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ESSENTIAL LEARNING OBJECTIVES: 
15.1 INTRODUCTION TO ANIMATION 
15.2 ADD/PLAY THE SOUND 
15.3 DO IT YOURSELF(THE LION AND THE MOUSE STORY)

15.1 INTRODUCTION TO ANIMATION:
Animation is the art of creating the illusion of movement by displaying a sequence of images rapidly. Our brains 
perceive these images as a continuous flow, bringing characters and objects to life on the screen. Scratch, with its 
intuitive interface and block-based coding, makes animation creation accessible and fun for everyone.

Animations can also be created by dragging and dropping blocks of code. The blocks represent actions, such as 

1.	 moving a character or/and

2.	 changing the costume or/and

3.	 changing the background or/and

4.	 adding sound effects 

that can be combined to create a complete animation. In Scratch, sprites/costumes and backdrops are essential 
elements that you use to create interactive animations and games

The Building Blocks of Animation: 

There are two primary techniques for creating animations in Scratch:

•	 You would use costumes to animate or change the appearance of the sprite in your story or game. You can 
create a new costume with the built-in paint utility, import an existing costume, or use your computer’s 
camera to take a picture and use it as a costume. By rapidly switching between these costumes, you create 
the illusion of movement. For example, a character sprite might have a costume for walking, running, and 
standing still.

•	 Animations can be created by simply dragging and dropping blocks of code. The blocks represent actions, 
such as moving a character or changing the background, that can be combined to create a complete 
animation.

A Sprite has these 3 basic attributes which we can change to make animations: Code, Costumes, Sounds.

ANIMATION IN 
S CRATCHCH

AP
TE

R15
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15.2 ADD /PLAY THE SOUND 
Whenever you play your favourite story, you are not only seeing the story, you are also hearing the story. You can 
listen to the characters speak; the music helps set the scene, and sounds (ones we might not even notice!) give us 
important information. These are all sound effects.

Sounds tell us a lot about what is happening!  You can pick a built-in sound, record your own, or upload one from 
your computer.

HOW TO ADD SOUND?
Follow the steps in this picture↓
To 

Add sound to the project:
1.	 Click the Sounds tab
2.	 Click Sound Library thumbnail - Alternatively, record or upload any sound file.
3.	 Select the audio clip  to play.
4.	 Play the sound
5.	 Delete the sound if not needed

Now that the sound is part of your project, you can use the Play Sound Block to play it!

HOW TO PLAY THE SOUND

1.	 Click backdrop/sprite thumbnail

2.	 Click Scripts tab

3.	 Click Sound under blocks category.

4.	 Drag the “Play Sound block” to Script 
Area

5.	 Select the sound to play from dropdown.
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EXAMPLE 1 – ANIMATING THE CAT
Creating a simple walking animation.

1.	 Open Scratch and create a new project.

2.	 Choose a sprite (or create your own!). For this example, let’s use the “Cat” sprite.

3.	 Click on the “Costumes” tab. This is where you’ll create the different poses for your walking animation.

4.	 Duplicate the original costume (right-click and select “Duplicate”). This will be your second walking pose.

5.	 Modify the second costume slightly. Move the cat’s leg forward, as if it’s taking a step. Repeat this process 
to create a third and fourth costume, showing the other leg moving forward/backward

Now, let’s bring these costumes to life!

1.	 Go to the “Scripts” tab for your sprite.

2.	 Drag the “when green flag clicked” block from the “Events” section onto the scripting area.

3.	 Inside the “when green flag clicked” block, connect a “forever” loop block from the “Control” section. This 
will ensure the animation keeps repeating.

4.	 Now comes the fun part! Use the “switch costume to” block (found in the “Looks” section) to switch 
between your four walking costumes.

o	 Drag four “switch costume to” blocks inside the “forever” loop.

o	 Click on the dropdown menu for each block and select the corresponding costume (costume 1, 
costume 2, etc.).

5.	 Finally, add a short “wait” block (from the “Control” section) after each “switch costume to” block. This 
controls the speed of the animation. Experiment with different wait times to see how it affects the walking 
speed.

Test it out! Click the green flag and watch your cat come alive with a simple walking animation!

You can combine motion blocks with other coding concepts like conditional statements (if/else) and loops (forever, 
repeat) to create intricate movements and reactions. For example, you could create an animation where a character 
jumps only when the space key is pressed.

6.	 Using Sound Effects: Adding sound effects brings your animation to a 
whole new level of engagement. Scratch offers a built-in sound library 
and allows you to import your own sound files. Imagine your walking cat 
animation accompanied by the rhythmic sound of footsteps!

7.	 The “Broadcast” Block: This powerful block allows multiple sprites to 
communicate with each other. Imagine creating a scene with multiple 
characters – using “broadcast” allows you to trigger animations in one 
sprite based on actions performed by another. This opens doors for 
interactive storytelling and game development.
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EXAMPLE: ANIMATING THE BAT 
1. Setup the stage. Select stage and import ‘Brick Wall 1’ from the 
BackDrop library.

2. Choose the bat sprite from the Sprite Library. Place the bat 
above ground as shown in figure.→

The bat has two costumes (bat1-a and bat1-b) to 
make the flying animation of the bat.

Bat Costumes

To change the costume of the bat, you have to use 
switch costume block from looks palette. In the drop down menu you will get the option to change 
the costume to bat1-a or bat1-b. Switch costume

Once you click on the block, it will be highlighted and the command will be 
executed. To animate the bat at a certain speed, we will add wait block from control 
palette for 0.5s. Then, we will again switch costume to bat1-b.

When you click the script, the bat will change costume to bat1-a, wait for 0.5s, switch costume to bat1-b and wait 
for 0.5s. This happens only once. Thus we will add forever block from control palette, to repeat the process again 
and again.

Again for running the script you have to click on the script. To run the script, 
whenever an action is perform, you add hat blocks. In this case we will add 
when green flag is clicked block from event palette.

Your animation is ready !!

15.3 DO IT YOURSELF: 
Create “THE LION AND MOUSE STORY” in Scratch.

Creating ‘The Lion and the Mouse’ story in Scratch involves breaking the story into scenes and 
programming each one. First, design your sprites- the lion, the mouse and any other characters 
or props. Use the backdrop editor for scene settings. Then code the characters to move and 
interact using Scratch’s drag-and drop interface. Employ broadcast messages to transition between 
scenes. Remember to add sound effects and dialogue to bring your story to life. By methodically 
segmenting your story, Scratch can help transform this classic fable into an interactive experience.
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EXAMPLE 2: →
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 BR AIN DEVELOPER 

I) CHOOSE THE CORRECT ANSWER

1. What is a sprite costume in Scratch?

A. The code that controls a sprite’s actions.
B. The appearance or visual features of a sprite.
C. The sound associated with a sprite.
D. The background image behind the sprite.

2. How can you add a new costume to a sprite in Scratch?

A. By importing an image file as a costume.

B. By using the “Paint New Costume” option.

C. By recording a new sound and assigning it to the sprite.

D. By selecting a sprite from the Scratch library.

3. What types of graphics can Scratch costumes be?

A. Bitmaps and Vectors

B. JPEGs and GIFs

C. PNGs and TIFFs

D. SVGs and EPS

4. How can you edit a costume in Scratch?

A. By selecting the costume and using the “Edit” button in the costumes tab.

B. By dragging the costume to the stage and modifying it there.

C. By using the “Upload” option to replace the existing costume.

D. By clicking on the sprite and selecting the “Change” button.

5. What are the two ways to get a costume or background for a sprite or stage in Scratch?

A. By drawing in the built-in editor or importing from a file.

B. By recording a video or using a web camera.

C. By copying from another sprite or painting with external software.

D. By selecting from the Scratch gallery or uploading a sound file.

6. How do you create an animation with multiple costumes in Scratch?

A. By using the “switch costume to ()” block in combination with a “wait” block.

B. By recording a sequence of actions in the “Animations” tab.

C. By using the “repeat until” block to cycle through costumes.

D. By dragging costumes into the “Animations” section of the sprite.
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7. What does the if on edge, bounce block do in Scratch?

A. It makes the sprite disappear when it touches the edge of the stage.

B. It causes the sprite to bounce off the edge of the stage.

C. It changes the sprite’s costume when it touches the edge.

D. It moves the sprite to a random position when it touches the edge.

8. What are the three rotation styles available for sprites in Scratch?

A. Clockwise, Counterclockwise, and No Rotation

B. Left-Right, All-Around, and Don’t Rotate

C. Vertical, Horizontal, and Diagonal

D. Flip Horizontal, Flip Vertical, and Fixed

9. What is the primary use of the “Play Sound” block in Scratch?

A. To change the sprite’s costume.

B. To play a sound effect or music within the project.

C. To move the sprite to a new location.

D. To switch backgrounds in the project.

Teacher’s Signature
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ESSENTIAL LEARNING SKILLS
16.1 VARIABLES

16.2 CREATING A VARIABLE

16.3 USING VARIABLES

16.4 EXAMPLE 1

16.5 ADVANCED USES

16.6 EXAMPLE 2

16.7 DO IT YOURSELF

16.1 WHAT ARE VARIABLES?
Variables in Scratch is a great way to manage and manipulate data in your projects. Variables in Scratch are like 
containers that hold values. These values can be numbers, text, or even true/false values. They allow you to store 
and change data as your project runs.

16.2CREATING A VARIABLE
In Scratch creating a variable allows you to store information that you can use and modify in a project. Here’s how 
to create a variable.

1.	 Go to Variables category.
2.	 Click on Make a Variable button.
3.	 A dialog box will appear asking you to Name the Variable. Enter a name for the variable
4.	 Choose who the variable applies to - for all sprites (global) or for this sprite only (local).
5.	 Click OK: Your variable will now appear in the blocks palette.

16.3 USING VARIABLE
After creating the variable, you will see it in the variable section. 5 New blocks appear that will allow you to use 
the variable.

1.	 Set Variable: Assign a value to your variable.
2.	 Change Variable: Change the value of the variable by a specified amount.
3.	 Show/Hide Variable: Display/Hide the  from the stage.
4.	 Variable: A block that reports the current value of the variable.

These blocks can be used in scripts to manage things like scores, timer, or any other data you want to keep 
track of.

WORKING WITH 
VARIABLES & GAMINGCH

AP
TE
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16.4 EXAMPLES:
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16.5 ADVANCED USES
Variables can also be used for more complex tasks like controlling sprite movements, storing user inputs, or 
even creating timers. The 3 stages of a variable in a project are

1.	 Creating the Variable: Name the score.
2.	 Set Initial Value: At the start of the game, set the score to 0 using set [score] to [0].
3.	 Alter the value of the variable: When the player earns points, use change [score] by [(-)1] to increase/

decrease the value.
Here’s a simple example of using a variable in a game:

16.6 EXAMPLE 2: JUMPING GAME - (HAVE A SPRITE JUMPING OVER 
MOVING OBSTACLES)
In 5 steps

1.	 Make a sprite jump

2.	 Make a moving obstacle

3.	 Stop the game

4.	 Add more obstacles

5.	 Keep score

STEP 1 - Pick a sprite and make it jump: You can pick any sprite. Here we have used Avery. Change the backdrop 
to blue sky. To make the sprite jump upwards use the block change y by 10. Repeat this 10 times to jump the sprite 
really high. To get it back down use the change by -10 block and repeat this 10 times again. Use the when space 
key pressed hat block to trigger the jump. Now press the space key to jump the sprite. To enhance the jump by 
making it play a sound while jumping add the block play 
sound pop. 

STEP 2 - Make a moving obstacle: Pick another sprite for 
the obstacle. We have chosen the beachball as the obstacle 
sprite. Obstacle must be smaller than jumping sprite so 
that it can jump over the obstacle sprite. Make the baseball 
smaller by setting the size to 50% using the set size to 50% 
block or use shrink tool. Next the beachball should begin  
from the right end of the stage and glide over to the left 
end of the stage. To tell the beachball the starting spot on 
the stage – position it at the starting spot and then drag the 
GoTo X & Y block(motion category) over to script area. 
From here we want the beachball to glide to a spot on the 
left end of  the stage. Place the baseball at the left end of 
the stage and drag the glide for (1) sec X, Y block over  to 
script are and connect it to the goto X, Y block there. Now 
the ball glided once. But we want more baseballs to keep 
coming. To do that place the two connected blocks in the forever block. Top it with the when green flag clicked hat 
block(event category) Glide for 1 second is a little fast so change 1 second to 3 seconds in glide block. 

(Every position on the stage has an X value and an Y value. X represents the horizontal position on the stage and 
Y represents vertical position on the stage. The goto X, Y and the glide X, Y blocks in the blocks palette will 
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automatically get updated with the X and Y values of the sprite position.)

STEP 3: Make the game stop when ball runs into the jumping sprite. There is a block stop all that will stop 
everything in your project. Drag thig this block. And make the baseball wait until its touching Avery and if it does 
touch Avery have it stop the game. 

Sometimes the baseball gets stuck in the air because the code gets stopped and has not got finished with the jump 
so it gets frozen there. To fix this by making Avery goto a starting position when the game starts. Position Avery 
where you want her on the stage and drag the goto X, Y block and make that happen when green flag clicked.

STEP 4: Add more obstacles Right click baseball and click duplicate. We have another baseball with all the same 
code as the first baseball. When you try it you can’t see the duplicate ball that’s because it is right on top of the 
first ball. The two balls have exact same code and gliding at the exact same time. Lets make the second ball wait 1 
second so they get spaced out from each other. This looks good but the second ball appears siting in the middle of 
the screen while it waits for 1 second. So hide it when the project starts – so it is invisible and then make it show 
after 1 second.

 STEP 5: Keep Score So the player earns points every time they jump over the ball. To do this, make a variable. In 
scratch you can use a variable to keep track of certain number in your project.  Lets make a variable called score and 
use it to keep track of the players score. Everytime the player completes a jump increase the value of score variable 
by 1 and when a player looses and the project restarts Set the score variable back to 0.			  		
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16.7 DO IT YOURSELF:
Create scratch code for the HIGH – LOW game.

1.	 Computer will generate a random number between  1 and 100 store it in variable N.

2.	  Create variable X.

3.	 Use ask block to input value for X.

a.	 Check if X is less than N AND If YES -> SAY “LOW”

b.	 Check if X is greater than N AND If YES -> SAY “HIGH”

c.	 Check if X is equal to N AND If YES -> SAY “Good, You found the  number in … chances”

4.	 Do step 3 in 5 chances.

QUESTION: The code for this is given in the picture.. Create 
a score variable to keep score.

The score is 5 if number of chances is 1
The score is 4 if number of chances is 2
The score is 3 if number of chances is 3
The score is 2 if number of chances is 4

      The score is 1 if number of chances is 5 
       else score is 0.

Here is a sample script of a Calculator.→



94

 BR AIN DEVELOPER 

I) CHOOSE THE CORRECT ANSWER

1. What are variables used for in Scratch?

A. To create new sprites

B. To store and manipulate data

C. To set the backdrop for the stage

D. To add sounds to your project

2. How do you create a new variable in Scratch?

A. Click on the “New” button in the Costumes tab.

B. Click the “Make a Variable” button in the Variables category.

C. Drag a “set [variable] to [value]” block to the script area.

D. Select “Create Variable” from the File menu.

3. Which block would you use to change the value of a variable by a certain amount?

A. Set [variable] to [value]

B. Show variable [variable]

C. Change [variable] by [value]

D. Hide variable [variable]

4. What is the purpose of the “show variable [variable]” block?

A. To set the value of the variable

B. To increase or decrease the variable’s value

C. To display the variable on the stage

D. To hide the variable from view

5. In Scratch, which block initializes a variable to a specific value at the start of the game?

A. Set [variable] to [value]

B. Change [variable] by [value]

C. Show variable [variable]

D. Hide variable [variable]

6. What is the first step in creating a game in Scratch 2.0?

A. Adding sounds and effects

B. Designing the backdrop

C. Creating a new project

D. Adding sprites
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7. How do you make a sprite move with the arrow keys in Scratch?

A. Use the “change [variable] by [value]” block.

B. Use the “when [key] key pressed” block and motion blocks.

C. Use the “play sound [sound] until done” block.

D. Use the “set [variable] to [value]” block.

8. How can you detect collisions between sprites in Scratch?

A. By using the “change [variable] by [value]” block

B. By using the “Sensing” blocks

C. By using the “Looks” blocks

D. By using the “Control” blocks

9. What should you do to test and debug your Scratch game?

A. Save your project

B. Run your game and fix any issues by adjusting the blocks

C. Create new variables

D. Change the backdrop

10. What is a common use of variables in a game created in Scratch?

A. To choose a sprite from the library

B. To manage the score

C. To add a new backdrop

D. To draw a new costume
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APPENDIX
QUESTIONS YOU SHOULD ANSWER

 A Fill in the blanks with the correct words.

1.	 A variable is an element whose value can vary or change.

2.	 A Hat block has a notch at the bottom.

3.	 The value of the Boolean block is either True or False.

4.	 The sensing blocks are used to detect various digital and analog inputs.

5.	 The Forever block will run the programming code infinitely.

B Write T for the true statement and F for the false one. Correct the false statement(s).

1.	 The Data block is used to create a variable. T

2.	 The Hat blocks are used to start the execution of a project. T

3.	 The If block is executed when the condition evaluated is False. F (when the condition evaluated is True)

4.	 The Repeat block can be used to run the code continuously. T

5.	 Motion blocks are colour-coded green. F (colour-coded blue)

C Choose the correct option.

1.	 A sprite can be animated by ________.

a. changing the backdrop’s costumes

b. changing the sprite’s costumes

c. using conditional block

d. using looping block

2.	 Which block is used to start the execution of a Scratch script?

a. Reporter

b. Stack

c. Hat

d. Cap

3.	 Which block is used to move smoothly from one position to another on the stage?

a. go to x: 0 y: 0

b. glide 1 secs to x: 0 y: 0

c. if on edge, bounce

d. go to mouse pointer
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4.	 Which block is used to change to a particular costume?

a. switch backdrop to backdrop 	 b. next costume

c. show				    d. switch costume to costume2

5.	 Which block is used to change the size of the pen in Scratch?

a. set pen color to 0

b. set pen size to 1

c. change pen color by 10

d. change pen shade by 10

D Answer the following.

1.	 Name all the block categories present in Scratch 2.0.

Motion, Looks, Sound, Pen, Data, Event, Control, Sensing, Operators, More Blocks

2.	 Mention any two blocks used for repeated execution of programming code. What is the difference 
between them?

repeat: To repeat the execution of programming code for a specified number of times.

forever: To repeat the execution of programming code forever.

3.	 What are the two conditional blocks? Where are they present?

The two conditional blocks are if and if-else. They are present under the Control category of blocks.

4.	 Explain the working of the following blocks:

clear: It removes any pen marking from the Stage.

hide: It hides the sprite.

5.	 How will you change the red color to yellow color in the following block?

set pen color to red: By clicking inside the block’s color swatch and then select the yellow color.

6.	 What is the difference between the following blocks?

glide 1 secs to x: -66 y: -4 is used to move the sprite smoothly to given x, y coordinates. 
go to x: -66 y: -4 is used to position the sprite to the given x, y coordinates.

7.	 Write any two blocks that can be used to start a Scratch project. Where are they present?

a. Hat Block

b. When space key is pressed

They are present under the Events category of blocks.

E Extra Questions

1.	 A computer program is a set of instructions that instructs the computer to perform a specific task.

2.	 Programming refers to the process of creating a program or code using a programming language.
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3.	 Scratch 2.0 is a computer programming language to teach programming concepts to young students.

4.	 A Sprite is a graphic object on the stage.

5.	 The Stage is the place where you add your sprites.

6.	 When a Scratch project starts, an orange cat sprite appears in the middle of the stage.

7.	 The Green Flag button is used to start running a Scratch program.

8.	 The Stop button is used to stop running a Scratch program.

9.	 The Scratch programming language was developed by Mitch Resnick at the MIT.

10.	The ‘i’ button is known as the information button.

11.	There are 10 color-coded Blocks Drawers.

12.	The Grow button is used to increase the size of the sprite.

13.	The Shrink button is used to decrease the size of the sprite.

14.	The Duplicate button looks like a rubber stamp. It is used to make a copy of the sprite.

15.	The Delete button looks like a pair of scissors. It is used to remove a sprite.

16.	The C Block is also called Wrap block.

17.	Motion blocks are color-coded blue.

18.	Looks blocks are color-coded purple.

19.	Control blocks are color-coded gold.

20.	Events blocks are color-coded brown.

21.	Sound blocks are color-coded bright purple.

22.	Pen blocks are color-coded dark green.

23.	Sensing blocks are color-coded light blue.

24.	Operators blocks handle arithmetic calculations and Boolean operations.

25.	The Cap block is used to stop scripts.

26.	The Reporter block can hold character or numeric data.

27.	The Blocks Palette is the area in Scratch from where you drag and add the blocks in the Scripts area.

28.	The Blocks Drawer consists of 10 color-coded blocks.

29.	You can create a variable for a particular sprite or for all the sprites. True

30.	We can create games and quizzes in Scratch 2.0. True

31.	There are 6 block types. True

32.	The Stack block has a notch at the top and the bottom. True
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33.	What are the 4 ways to add a backdrop?

a. Choose backdrop from library

b. Paint new backdrop

c. Upload backdrop from file

d. New backdrop from camera

34.	What are the 4 ways to add a sprite?

a. Choose sprite from library

b. Paint new sprite

c. Upload sprite from file

d. New sprite from camera

35.	What are the 6 block types?

a. Hat block

b. Stack block

c. Boolean block

d. Reporter block

e. C block

f. Cap block

DIY ACTIVITY:
Objective:
Create a game where a sprite moves around the stage, changes costume when it touches the edge, and provides 
feedback based on user input.
Components:

•	 A sprite (e.g., a cat) that moves around.
•	 Edge detection to change the sprite’s costume.
•	 User feedback based on the sprite’s position.

Steps to Create the Game
1. Set Up the Sprite

1.	 Create a New Scratch Project:
o	 Open Scratch and start a new project.

2.	 Add a Sprite:
o	 Choose a sprite (e.g., the default cat sprite) or add a new one.

3.	 Add Costumes:
o	 Select your sprite and go to the Costumes tab.
o	 Add multiple costumes to the sprite to animate it (e.g., “costume1,” “costume2”).
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2. Program Movement and Edge Detection
1.	 Add a Forever Block:

o	 Drag the forever block from the Control category to the Scripts area.
2.	 Add Movement Inside the Forever Block:

o	 Inside the forever block, add the move (10) steps block from the Motion category.
3.	 Add Edge Detection with Costume Change:

o	 Below the move (10) steps block, add an if <touching [edge]?> then block from the Control category.
o	 Inside the if block, add the next costume block from the Looks category to change the costume 

when the sprite touches the edge.
o	 Add a play sound [pop] until done block from the Sounds category to give audio feedback.

Your code should look like this:
forever move (10) steps 

if <touching [edge]?> 
next costume
 play sound [pop] until done 

end 
end

Explanation:
•	 Forever Block: Continuously moves the sprite and checks if it touches the edge.
•	 If <touching [edge]?> then: Changes the sprite’s costume and plays a sound when touching the edge.
•	 If <key [space] pressed?> then: Increases the score and displays it when the space key is pressed.

This example demonstrates how to combine conditional statements and looping structures in Scratch to create an 
interactive and engaging project.
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User Skill
Typing Tutor
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T YPING TUTOR  
INT RODUCTION

	 The knowledge of touch typing has become inevitable today in the use of computers.

	 With typing tutor, you can learn touch typing in an easier and simple way.

	 It is very similar to you that there are 26 letters in English alphabet. All these 26 letters are presented in the 
computer keyboard too.

	 But, 26 letters are not arranged in an alphabetical order.

	 The letters in the keyboard is arranged in QWERTY order.

TYPING STEPS

Follow the steps below:-

Step 1: First of all place your hand on the keyboard.

Step 2: Place your

 Little finger of your left hand gently on the ‘A’

 Ring finger on ‘ S ’

 Middle finger on ‘ D ’

 Index finger for both ‘ F ’ and ‘ G ’

Step 3: Place your

 Little finger of your right hand gently  
on the key semicolon ‘ ; ’

	 Ring finger on ‘ L ’

 Middle finger on ‘ K ‘

 Index finger for both ‘ H ’ and ‘ J ’
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Step 4: Place both your left and right thumbs on the spacebar key.

Lets start typing. Whatever it may be letter or numbers all most all the keys you can see around your fingers.

LEFT HAND FINGER
Name of the Finger Keys on the Keyboard

Little Finger A

Ring Finger S

Middle Finger D

Index Finger F,G

Thumb Spacebar

RIGHT HAND FINGER
Name of the Finger Keys on the Keyboard

Little Finger ;
Ring Finger L
Middle Finger K
Index Finger J,H
Thumb Spacebar

THE QWERTY LAYOUT

The keys on the keyboard is arranged in QWERTY layout. The layout is referred to us as “QWERTY” because of 

the arrangement of the keys in the upper row is QWERTY.
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HOME ROW

The finger of an experienced typist never “rest” However, if we could ask the fingers where they spend most of their 

time, it is over the home row.

When you are still learning to access keyboard, be careful to keep at least one finger of each hand anchored over 

the home row.  

UPPER ROW / QWERTY ROW

QWERTY Row is located just above the Home row. It contains many number of characters.

LOWER ROW

Lower Row is located just below the home row, contains limited number of keys.

NUMBERS ROW

Numbers Row is located above the upper row, number keys are also available in a separate place at the right side 

of the keyboard.

ANCHORING

Anchoring means to keep a finger in very light contact with its home row key.

During the early stages of learning keyboard, this is necessary for the brain to develop a sense of position for the 

hands and fingers.

As you become a more skilled typist, your fingers will automatically move to the correct position of the keys.

 




